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1 Introduction

1.1 Welcome to QBOI (AyaNova's QuickBooks Online Interface)

Use of this online manual:

· To view topics, click on the chapter headings to expand

· This online manual provides information on configuring and setting up the
optional AyaNova QBOI (QuickBooks Online Interface) program and use of
QBOI features. Screenshots depicted in this manual may not display exactly as
your copy of QBOI, AyaNova and QuickBooks Online will be different.

· Familiarize yourself with the AyaNova service management program before
using QBOI - refer to the AyaNova Help file for details.

· Once familiar with AyaNova's features, then it would be suggested to start off
with:

1. The Overview of QBOI Features and the Overview of QBOI Use and
review the QuickBooks Online Inventory vs AyaNova Inventory section

2. Then proceed to QBOI Installation and setup of preferences
3. Note the Common Issues & Messages section if you encounter an issue
4. Review the section on linking, on importing your QB Online data

(customers, vendors, items) into AyaNova, and importing your AyaNova
data (clients, vendors, parts, rates) into your QB Online. 

5. Review the section on updating your existing linked QuickBooks Online
and AyaNova clients and parts.

6. Review the section on the Descriptive Text feature to have text from the
workorder display in the QuickBooks Online invoice

7. Refer to the Invoicing section for what and how data from the AyaNova
workorder is transferred to a QuickBooks Online invoice.

https://www.ayanova.com/onlinehelp.htm
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1.2 Overview of QBOI Features

AyaNova QBOI has the following features:

· Import clients, vendors and items from your QuickBooks Online company
data file into your AyaNova database

· Import clients, vendors, parts and rates from your AyaNova database into
your QB Online company data file

· Link existing AyaNova data with existing QB Online data
· Update existing linked parts information between AyaNova and QB Online
· Update existing linked client's information between AyaNova and QB Online
· Set linked parts pricing between your AyaNova database and your QB

Online company data file during the invoicing act
· Export data from AyaNova service workorders into QB Online invoices
· Consolidate multiple AyaNova service workorders into one QB Online

invoice
· Compatible with 64bit computers

· Import clients, vendors and items from your QuickBooks Online
 company data file into your AyaNova database

This way data is only entered once and ensures that the AyaNova items match
the QB Online items to facilitate converting AyaNova work orders into QB
Online invoices automatically.

· Import clients, vendors, parts and rates from your AyaNova database
into your QuickBooks Online company data file

For example - a new client requests service. Their client information is entered
into AyaNova. When it comes time to invoice via QB Online, you can just
import that AyaNova client's information into QB Online without the need to
manually re-enter again into your QB Online.

Or perhaps you have been using AyaNova for some time and just now
starting to use QB Online, import your AyaNova parts into your QB Online
which will also include the total On Hand amounts and total Reorder amounts
from your AyaNova parts at the time of that import.

· Link your existing AyaNova data with your existing QuickBooks
Online data

If you already have the same clients, vendors and/or items entered in both
AyaNova and QB Online, just link the existing data.
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Linking is different from importing in that the original AyaNova record is
preserved as-is and is marked internally with the record in QB Online that it
matches to.

This is also useful when you have records in AyaNova that differ from QB
Online.  For example, you may have multiple clients in AyaNova that
represent separate locations for service but want to link them all to a single
QB Online client for billing.

This is also useful if you have many pre-existing items in AyaNova as you can
link them to QB Online records without losing their historical data as you
would if you started with newly imported items.

If you have already entered in items (clients, parts, rates) into AyaNova, if
they have the exact same name as in QB Online, they can be auto-linked
instead of having to be manually individually re-linked.

And if you previously were using a desktop QuickBooks version with QBI and
have migrated to QB Online, you can auto-link existing AyaNova data with
existing data in QB Online!

· Update existing linked parts information between your AyaNova and
your QuickBooks Online

If you make a change to a part in AyaNova, just use the Refresh menu option
to update the information into the linked QB Online part.
Or vice versa, if you have made a change in QB Online, use the Refresh menu
option to update the information to the linked AyaNova part.

· Update existing linked client's information between your AyaNova
and your QuickBooks Online

If you make a change to a client in AyaNova, just use the Refresh menu
option to update the information into the linked QB Online client.
Or vice versa, if you have made a change in QB Online, use the Refresh menu
option to update the information to the linked AyaNova client.

Set linked parts pricing between your AyaNova database and your
QuickBooks Online company data file during the invoicing act

At the time of invoicing, if there is a difference between the AyaNova price
and the QB Online price, you can select to use the AyaNova price or use the
QB Online price, as well as have QBOI set either the AyaNova workorder price
to the QB Online price, or set the QB Online item price to that of the AyaNova
workorder part price. 

Export data from AyaNova service workorders into QuickBooks Online
invoices
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AyaNova QBOI can be used to quickly and easily turn AyaNova work orders
into QB Online invoices.  All billable items in an AyaNova work order can be
exported into an invoice in your QB Online.  This saves re-entering data
manually because the data in the service workorder is directly converted to a
QB Online invoice without any retyping of information.

AyaNova QBOI work order export into QB invoice has the following features:

§ Workorders are auto-selected for invoicing based on a specific AyaNova
workorder status set in your Preferences, Service Completed is
checkmarked but workorder is not yet Closed, and the Invoice # field is
empty

§ Price protection for parts: AyaNova QBOI flags part prices that differ in
your AyaNova from your QB Online. You can accept the difference, or
change the AyaNova service workorder, or change the AyaNova item
price, or change the QB Online price to match the AyaNova service
workorder - with a click.

§ Automatically ensures that work orders contain only items that are
recognized by QB Online. If an item has not yet been linked to
QuickBooks you can link it quickly and easily.

§ Set descriptive text to include on invoice for the work order – such as
work order number, Quick Description field from work order, unit
(client equipment) selected within work order, labor details, etc

§ Automatically set the QB Online "Class" on invoices via QBOI
Preferences. If you use Classes in QB Online you can select one of the
existing QB Online classes as a default for all invoices created through
AyaNova QBOI.

§ Choice of invoicing out per service workorder, or consolidate service
workorder billable information into one invoice for the same client

§ Set invoices created by AyaNova QBOI to "Ready to print" status in QB
Online via Preferences. This means that you can print all the invoices at
once from your QB Online.

§ All data sent to your QB Online in the process of creating invoices is
automatically verified by your QB Online for validity. 

Consolidate multiple AyaNova service workorders into one QuickBooks
invoice

Easily  consolidate billable service workorders for the same QB Online client,
or simply select to invoice out each service workorder individually.
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1.3 Suggested order for use

We suggest the following order from installation, configuration, initial mapping
before using QBOI for invoicing AyaNova completed service workorders into
QuickBooks Online invoices.  Of course, you can also do your importing/linking as
you go along, this is just a suggestion.

1. Perform the Installation & Configuration to install the QBOI files,
authenticate with your QB Online data, and set up your Preferences 
a. QBOI installation
b. Start QBOI for the first time which includes setting Preferences

2. Perform the mapping (linking) of already existing data between the
two databases, then import.

Recommended order of doing so is as follows:

a. Clients
i. Link existing clients in both AyaNova and QuickBooks Online (either

manually and/or via Auto-Link)
ii. Import non-linked clients from AyaNova to QuickBooks Online
iii. Import non-linked clients from QuickBooks Online to AyaNova 

b. Vendors
i. Link existing vendors in both AyaNova and QuickBooks Online (either

manually and/or via Auto-Link)
ii. Import non-linked vendors from AyaNova to QuickBooks Online
iii. Import non-linked vendors from QuickBooks Online to AyaNova (based

on type of vendor)
1. (please note - if Wholesalers are not yet linked before importing

QuickBooks Online Items into AyaNova, you will not be able to
select those parts in AyaNova in purchase orders )

c. Service Rates
i. Link existing AyaNova Service Rates with QuickBooks Online (either

manually and/or via Auto-Link)
ii. Import non-linked Service Rates from QuickBooks Online to AyaNova 
iii. Import non-linked Service Rates from AyaNova to QuickBooks Online 

d. Travel Rates
i. Link existing AyaNova Travel Rates with QuickBooks Online (either

manually and/or via Auto-Link)
ii. Import non-linked Travel Rates from QuickBooks Online to AyaNova 
iii. Import non-linked Travel Rates from AyaNova to QuickBooks Online
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e. Parts
i. Link existing parts in both AyaNova and QuickBooks Online (either

manually and/or via Auto-Link)
ii. Import non-linked parts from QuickBooks Online to AyaNova
iii. Import non-linked parts from AyaNova to QuickBooks Online (will also

import the AyaNova part's total On Hand amounts and the Reorder
amounts)

3. Edit descriptive text to use on QuickBooks Online invoices

a. If you do print out from AyaNova a detailed completed report for each
workorder to accompany your QB Online invoice, the descriptive text you
use in the invoice could just be the workorder number(s) on the invoice

b. OR if you do not print out from AyaNova a detailed completed report for
each workorder to accompany the invoice, instead use descriptive text to
include specific information from specific fields of the
workorder(s) to display right on your QB Online invoice itself -
such as workorder number(s),  schedulable user(s) that performed the
service, start and stop Labor times, workorder item summaries, details
from each Labor item

4. Use QBOI to invoice AyaNova service workorders into QuickBooks
Online

a. Fix unlinked data (client or parts etc) or price differences between linked
AyaNova and QuickBooks Online parts

b. Invoice single or multiple service workorders via QBOI into QB Online.
c. Your QB Online invoice will reference the service workorder #, so you can

easily compare if needed. 
d. Your AyaNova service workorder will include the QB Online invoice # so

you can easily compare if needed.

5. Refresh parts information and clients information

a. Update mapped/linked parts between AyaNova and QB Online using the
Refresh QB Online record or the Refresh AyaNova record menu option in
the AyaNova parts grid or the part's entry screen

b. Update mapped/linked clients between AyaNova and QB Online using the
Refresh QB Online record or the Refresh AyaNova record menu option in
the AyaNova clients grid or the clients entry screen

NOTE: QBOI only obtains QB Online and AyaNova information when QBOI first
loads
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If you enter new information into either QB Online or AyaNova with QBOI running,
you need to refresh the connections in 4 possible ways:

1. Select to Refresh QuickBooks Online connection from the main AyaNova
window

2. From within QBOI Main menu Tools, select Refresh QuickBooks Online
connection

3. If not seeing AyaNova service workorders that are ready for invoicing, from
QBOI's menu Invoices select Refresh invoices
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1.4 QuickBooks Inventory VS AyaNova Inventory

A common question asked by service companies using AyaNova along with the
optional add-on QBOI that includes Inventory Items is "Do I use AyaNova inventory
features (PO's, serial numbers, part requests, etc), or do I QuickBook Online's
inventory features (POs, etc) or a combination of both?". 

The answer to that depends on what you want to do!

Benefits of using AyaNova's inventory features along with your
QuickBooks Online
If DO NOT want to use AyaNova's Purchase Orders and its inventory
benefits, do the following:
If WANT TO use AyaNova's Purchase Orders and its other inventory
benefits, do the following:
If want to use combination of both, do the following:

Benefits of using AyaNova's inventory features along with your
QuickBooks Online

AyaNova inventory includes a number of unique features:

Part Requests
· With AyaNova Part Request feature, a user can request a part (and quantity

and for a specific warehouse) from the AyaNova service workorder. 
· The Part Request is "tied" to that specific service workorder
· Purchasing can easily include in an AyaNova Purchase Order the parts

requested to be ordered tied to the specific service workorder
· And when the part is received in AyaNova, if subscribed to the notification

"Workorder item part request – parts received", the user logged in who
requested the part will be notified the part has been received; and the
scheduled user in that service workorder will be notified that the part has
been received so that the service can be provided.

Part Inventory
· Quantity on-hand in AyaNova is based on:
o  what has been entered into inventory via AyaNova's Part Adjustments
o  and/or entered into inventory via AyaNova's Purchase Order Receipts
o and/or the quantity on-hand is immediately updated whenever anyone

indicates the part quantity set in a AyaNova service workorder has been
Used In Service and the workorder saved.
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o and/or the quantity on-hand is immediately reversed when a saved Used
in Service part is deleted

· This way you can always see at a glance via the Part Inventory grid what
warehouses (if used in AyaNova) have what quantity of what parts on-hand

Serialization
· You can track serial numbers for Parts in AyaNova
· When receiving parts into inventory via an AyaNova Purchase Order Receipt

or entering inventory in via an AyaNova Part Adjustment, if the part has
been set as serialized, you can enter serial numbers for the received parts.

· And in the AyaNova service workorder, when you select a serialized part,
AyaNova will automatically identify this setting the part quantity to 1 and
opening the Serial Number field so that you can drop down and select from
the list of available serial numbers for this part in inventory.

Whereas with QuickBooks Online inventory:

· AyaNova is not an accounting program and does not include Accounts
Payable. AyaNova does not remind you how much you owe to your
vendors, nor when to pay them.

· QBOI does NOT have the ability to import AyaNova's Purchase Orders nor
AyaNova's Purchase Order Receipts into your QB Online database. These if
required, must be manually entered in your QB Online database. Or a
modified version stating total amounts, etc only entered so your AP are
maintained.

· Do note that when QB Online inventory items are sold in an invoice
generated by using your QBOI to bill out your AyaNova service workorders,
your QB Online inventory on hand amounts is updated by your QB Online
itself automatically too!

If DO NOT want to use AyaNova's Purchase Orders and its inventory
benefits, do the following:

If you want to use your QuickBooks Online inventory only, so that when
receiving it updates your Accounts Payable to your vendors

1. Complete your QBOI installation, QBOI preferences, QBOI Mapping &
Importing and your QBOI Descriptive Text setup.

2. Once all of your AyaNova parts and their existing on hand and reorder
amounts have been imported into your QB Online with Inventory (i.e.
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Plus version), NOW TURN OFF INVENTORY IN YOUR AYANOVA
before any further work in your AyaNova.
a. Refer to your AyaNova Help documentation "Global Settings" section

for how to.
b. Disabling inventory in AyaNova will disable the ability to create

AyaNova POs, PO receipts, tracking serial numbers etc. It will not
affect your QuickBooks Online abilities to do so.

c. Don't worry, disabling inventory in AyaNova will still allow you to
identify parts sold to customers in your AyaNova service workorders
as well as include additional Description text such as serial numbers
etc.

3. Use QuickBooks Online only for entering PO's and for receiving
inventory
a. This way you have only one program that you are entering such data

4. NOTE: Don't worry, when QuickBooks Online inventory items are sold
in an invoice generated by using your QBOI to bill out your AyaNova
service workorders, your QuickBooks Online inventory on hand
amounts will be updated too by your QB Online!
a. In an AyaNova workorder, you select a part and enter its quantity.
b. If a part is serialized and you want that serial number identified, just

enter the serial number in the Description field in the Part record in
the AyaNova service workorder

c. Any text entered in the Part Description field will display in the
QuickBooks Online invoice

If WANT TO use AyaNova's Purchase Orders and its inventory benefits, do
the following:

1. Confirm that your AyaNova's Use Inventory is set to True in its Global
Settings.
a. Refer to your AyaNova Help documentation "Global Settings" section

for how to confirm this is set (as is the default).
2. Complete your QBOI installation, QBOI preferences, QBOI Mapping &

Importing and your QBOI Descriptive Text setup.
a. Refer to your AyaNova Help documentation for steps on how to

enter opening inventory on hand amounts in your AyaNova 
3. Use AyaNova for creating Purchase Orders and for receiving

a. Take advantage of AyaNova features such as Part Requests in service
workorders to order parts for specific workorders

b. Take advantage of AyaNova inventory serial numbers entry and
selection in workorders

4. The suggestion, as you have the Purchase Order details and receipts in
your AyaNova, is that in your QB  Online Accounts Payable, is to just
enter total amounts manually into your QuickBooks Online for what you
owe vendors that you have  purchased for resale. 



16

AyaNova QBOI Help 
 
                                                                                                                                                                                                                   © 1999 - 2018 Ground Zero Tech-Works Inc

Introduction

i. i.e. Enter the subtotals of an AyaNova PO, tax amounts, shipping
costs etc only in your QB Online rather than each part and its
costs

5. NOTE: Don't worry, when QuickBooks Online inventory items are sold
in an invoice generated by using your QBOI to bill out your AyaNova
service workorders, your QuickBooks Online inventory on hand
amounts will be updated too!

If want to use combination of both, do the following:

1. Confirm that your AyaNova's Use Inventory is set to True in its Global
Settings.
a. Refer to your AyaNova Help documentation "Global Settings" section

for how to.
2. Complete your QBOI installation, QBOI preferences, QBOI Mapping &

Importing and your QBOI Descriptive Text setup.
a. Refer to your AyaNova Help documentation for steps on how to

enter opening inventory counts in your AyaNova 
3. Use AyaNova for creating Purchase Orders and for receiving, AND

REPEAT creation of these POs and the receiving in your QuickBooks
Online.

4. NOTE: Don't worry, when QuickBooks Online inventory items are sold
in an invoice generated by using your QBOI to bill out your AyaNova
service workorders, your QuickBooks Online inventory on hand
amounts will be updated too as your QB Online automatically does that.
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2 Installation & Configuration

2.1 Common Issues & Messages

QBOI is not listed as an option in the Plugins menu
Messages when loading QBOI program
Issues importing or linking
Issues invoicing

Issue: QBOI is not displaying as an option in the Plugins menu

This may occur due to two possible reasons:

1. You have not completed successfully the QBOI installation

2. And/or your AyaNova database is not licensed for the optional add-on QBOI subscription

1. Log into your AyaNova desktop program
2. Select from the main menu Help -> About AyaNova

a. If your Registered To: shows Unregistered trial

i.
ii. Scroll down further and confirm that QBOI is listed as one of your licensed

plugins.
iii. If QBOI is not listed, copy all text and contact us directly, requesting a

temporary key so you can fully try out QBOI as well as all features of
AyaNova and all other options without any restrictions!

b. If instead your Registered To: shows your company name
i. Scroll further down to under Plugins:
ii. If QBOI is listed as one of the licensed plugins. 

a. Confirm your QBOI's subscription is current (not expired)



19

AyaNova QBOI Help 
 
                                                                                                                                                                                                                   © 1999 - 2018 Ground Zero Tech-Works Inc

Installation & Configuration

b.
iii. If QBOI is not listed as one of your licensed subscribed plugins, and would

like to trial QBOI before purchasing a subscription, please email 
support@ayanova.com with the following:
1. Select Copy config and log file to clipboard from the menu of About

AyaNova
2. Open Notepad, select Edit -> Paste. Save. Attach to your email to 

support@ayanova.com
3. Let us know in your email:

a. that you would like to trial QBOI
b. what country version of QB Online you are using 
c. what type (i.e. Simple Start; Essentials, Plus, etc)

4. And we would be pleased to send you out a temporary subscription
Key to apply to your database so that you may fully trial before
purchase of the QBOI subscription

    

Issue: If you receive any error message, due to QB Online's intermittent loss of its authentication token
or "blips in their system" as QB Online users put it, at times you may find that the solution is to start
again:

· Exit out of AyaNova. 
· Clear your default web browser cache
· Log into your QB Online database
· Log into AyaNova
· Load QBOI
· Successfully authenticate
· Then perform the action again.

Issue: As the message states, one or more workorders do not have a Service rate (or the message
could refer to a Travel rate) selected.

mailto:support@ayanova.com
mailto:support@ayanova.com
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Solution 1:
1. If you select Abort or the red X in the corner, QBOI and your AyaNova will exit.
2. Log back into your AyaNova
3. Fix the workorder referred to in the error message

a. as per the example error above: uncheck Service Completed in workorder #73 so you
can edit the workorder as needed, save, checkmark Service Completed, Save & Exit
out of the workorder

4. Start your QBOI and authentic (as you had exited out of AyaNova, the authentication
token will have been removed)

5. Continue now with QBOI

Solution 2:
1. If you select Ignore, your QBOI Main will display with no menu options and whited out

2.
3. Exit out of QBOI Main by selecting the red X in the upper right hand corner
4. Fix the workorder referred to in the error message

a. as per the example error above: uncheck Service Completed in workorder #73 so you
can edit the workorder as needed, save, checkmark Service Completed, Save & Exit
out of the workorder

5. Refresh your QBOI connection from your main AyaNova Plugins -> AyaNova QBOI ->
Refresh QuickBooks connection

6. Run your QBOI Main again from your main AyaNova Plugins -> AyaNova QBOI -> QBOI
Main

7. Continue now with QBOI

 

Issue:  Receive a message such as below along the lines of:

The QuickBooks Item previously set for .... no longer appears to be valid. Youwill next be
prompted to re-select a valid QuickBooks Item.
(image below is one possible example)

Possible causes:
1. This may be an indication that the QB Online item has been set to inactive
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2. This may be an indication that you have connected to a different QB Online database then
you used before.

Possible solutions:
1.a In your QB Online database, find the QB Online Item you had previously selected for this,
confirm is active.
1.b Confirm you are connected to the correct QB Online database.
2. Exit out of QBOI and out of your AyaNova. Exit out of your existing QB Online and close
your web browser. Clear your web browser cache. Now start again.

Issue: Receive a message such as below along the lines of:

Linked object: object type: object name
Is missing or set Inactive in QuickBooks

Remove its link from AyaNova?

Possible causes and solutions:

1. Confirm you are connected to your correct QB Online database that you have previously
connected to when linking and importing. 
If not connected to the correct QB Online database, select Cancel, exit out of QBOI and exit
out of your AyaNova. Exit out of your existing QB Online and close your web browser. Clear
your web browser cache. Now start again.

2. If connected to the correct QB Online database, confirm whether the object stated was set
to inactive. 
If was, and you need this object linked so you can invoice, set to active and select No above.
If was set to inactive and you no longer use, you can click Yes to remove its link from
AyaNova.
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Issue: You are trying to link existing items, but every time you select a item, it pops up information
about the item instead of letting you select and drag it to the item you want to link to

Solution:
You need to select the object indicator (square to the left of the item) and drag that. Refer
again to the screenshots and steps provided in the link or import section.

m

Issue: You are trying to import existing items either importing from AyaNova to your QB Online or
importing your QB Online data to your AyaNova, but every time you select a item, it pops up information
about the item instead of letting you select and drag it to drop to import

Solution:
Same as with the issue above, be sure to select the object indicator (square to the left of the
item) and drag that.

Issue: You had imported QB Online items into your AyaNova as parts. But you are unable to select any
of the imported parts in an AyaNova purchase order.

Cause:
Because the QB Online vendor was not imported into AyaNova or because the AyaNova
vendor was not mapped to the QB Online vendor BEFORE you imported the QB Online
parts into AyaNova, the result is no vendor selected in the newly imported AyaNova parts
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Solution:
You will need to manually edit each part in your AyaNova that was imported from QB Online
via QBOI, selecting a vendor in that AyaNova part's entry screen.

Issue: You use the Export unlinked items into QuickBooks menu option from the AyaNova Parts grid /
AyaNova Client grid and receive a message similar to:

Export AyaNova parts to QuickBooks Online completed with some errors:

ImportAyaPart: QuickBooks Online won't allow import of CD4583
Due to the following error:
QuickBooks Online validation rule broken:
The name supplied already exists. : Another product or service is already using this 
name. Please use a different name.

Cause:
As the message states, there already is an Item in your QB Online that has the same name or
number.

Solution(s):
1. Check your QB Online database - is the item/client already in your QB Online database?
2. Refresh your QB Online connection and then view via QBOI Main -> Tools -> Map & Import

and select the appropriate object - is that client/part already showing linked between
AyaNova and QuickBooks Online?

3. If not linked, use the Auto-link menu option to link

Issue: You attempt to import AyaNova parts into your QB Online database but receive similar to the
following message:

Import completed with some errors:

ImportAyaPart: QuickBooks Online won't allow import of PARTAAA



24

AyaNova QBOI Help 
 
                                                                                                                                                                                                                   © 1999 - 2018 Ground Zero Tech-Works Inc

Installation & Configuration

Due to the following error:
QuickBooks Online validation rule broken:
Feature Not Supported Error : We're sorry. This feature is not included in your
QuickBooks Online XXXXX subscription.  
(where XXXXX is your current type of QB Online - i.e. Essentials, Plus)

Cause:
As the message states, your version of QB Online must support what you are attempting to
do. 

In the example above, only the Canadian Plus version of QB Online supports Inventory Items,
so therefore you can ONLY import your AyaNova parts into a Plus version

Possible solutions: 
· Upgrade to the version of QB Online that does support inventory, and redo your Preferences

and Map & Import. 
· Manually create one or more non-inventory Item(s) in your QB Online, refresh, then manually

link as needed your AyaNova parts to the non-inventory Item(s). Then when you invoice, you
will and can tell QBOI to tell your QB Online to use the AyaNova part price

Issue: No service workorders display as ready for invoicing even though you are sure there are

Solution:
Please refer to the section in this documentation titled No service workorders ready for
invoicing as if you do have workorders ready for invoicing, one of the required four settings
are not applied to the workorder(s)

Issue: You select Invoice Selected Items to QuickBooks Online, but the service workorders continue to
display in the QBOI list, and the invoices are not created in QuickBooks Online.

Solution: 
You have not selected what you actually want to invoice. 
QBOI allows you to select individual or multiple service workorders at one time. Use your
mouse to click on the object indicator (square to the left of the client name or to the
left of the row depicting the service workorder number) and than either right-click and
select Selected Items to QuickBooks Online, or select the menu Invoices -> Selected Items
to QuickBooks Online.
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And you can also hold down the CTRL keyboard  key, and select multiple service
workorders / client names to invoice all ready to invoice service workorders.

Issue: The price set in your QB Online invoice for an AyaNova Outside Service charge, or for an
AyaNova Misc Expense charge or for an AyaNova Travel or AyaNova Service charge is not what the
price is in your QB Online item price - but instead is from what shows is the AyaNova workorder's retail
charge for that item

Solution:
This is as expected.
Do refer to the sections under Invoicing regarding these items:

· For the charge shows on your QB Online invoice for an AyaNova Outside Service
charge

· For the charge shows on your QB Online invoice for an AyaNova Misc Expense charge
· For the charge shows on your QB Online invoice for an AyaNova Travel charge or an

AyaNova Service charge 

Issue: You've edited service workorders, or edited AyaNova or QuickBooks Online objects, but QBOI
does not display these changes

Solution:
QBOI only obtains information about your QB Online and AyaNova information when QBOI
first loads.
If you enter new information into either QB Online or AyaNova with QBOI running, you need
to refresh your QBOI connections 

Issue: You select to invoice, and receive error message similar to one of the following:

PartPickList: ID not found:

or 

ClientPickList: ID not found:

or 

RatePickList: ID not found:

Solution:
QBOI only obtains QuickBooks Online and AyaNova information when QBOI first loads
If you enter new information into either QuickBooks Online or AyaNova with QBOI running,
you need to refresh your QBOI connections in 4 possible ways:

1. Exit out of QBOI and start it again
2. Or select to Refresh QuickBooks Online connection from the main AyaNova window
3. Or from within QBOI, select Refresh QuickBooks Online connection
4. Or if not seeing AyaNova service workorders that are ready for invoicing, from QBOI's
Invoices menu select Refresh invoices 
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Issue: You receive similar to the following message when attempting to invoice:

Invoice: Invoicing failed due to the following error:
QuickBooks Online validation rule broken:
-----------------------------------
Most likely reason for this error:
You are attempting to Invoice one or more items that do not have a sales tax set in
QuickBooks Online.
-----------------------------------
Business Validation Error: Make sure all your transactions have a TAXCODE rate before
you save. (wording of TAXCODE depends on your country version - i.e. if Canadian, may say
GST/HST)

Cause:
As the message states, the QB Online Item linked to the AyaNova part attempting to be invoice
does NOT have a tax setting.

Solution:
1. View your Tools -> Map & Import -> Objects -> Parts and find the AyaNova part(s) in the list

that are to be invoiced in the ready to be invoiced AyaNova workorders
2. Under the AyaNova side, click on the AyaNova part to identify which QB Online Item it is

linked to
3. In your QB Online, edit this Item and set its tax setting. Save
4. Refresh your QuickBooks connection
5. Now attempt the invoice again.
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2.2 QBOI Installation

It is always recommended to read through all instructions first, and than
perform the actual steps

1. Requirements before proceeding

Do not proceed until you have answered YES to each of these requirements:

a. Do you have a QB Online account?
QBOI is compatible with US versions of QBOI 
QBOI is also compatible with non-US versions of QBOI (i.e. Canadian,

UK, etc)
QBOI is compatible with all versions of QuickBooks Online 

· except the lowest end version called "Self-Employed" (as that version doesn't have
actual accounting functions, just the ability to track your time and make invoices -
so you may as well just use AyaNova which will provide you with that ability plus
many more features!)

b. Can you successfully log into and access your QB Online company data
file? 

c.  Confirm that your AyaNova database has a current subscription license for
QBOI (either as part of your 45 day trial or purchased)

1. Log into your AyaNova desktop program
2. Select from the main menu Help -> About AyaNova

a. If your Registered To: shows Unregistered trial

i.
ii. Contact us providing this information and requesting a

temporary key so you can fully try out QBOI as well as all
features of AyaNova and all other options without any
restrictions!

b. If instead your Registered To: shows your company name
i. Scroll further down to under Plugins:
ii. If QBOI is listed as one of the licensed plugins. 
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a. Confirm your QBOI's subscription is current (not
expired)

b.
iii. If QBOI is not listed as one of your licensed subscribed

plugins, and would like to trial QBOI before purchasing a
subscription, please email  support@ayanova.com with the
following:
1. Select Copy config and log file to clipboard from the

menu of About AyaNova
2. Open Notepad, select Edit -> Paste. Save. Attach to your

email to  support@ayanova.com
3. Let us know in your email:

a. that you would like to trial QBOI
b. what country version of QB Online you are using 
c. what type (i.e. Simple Start; Essentials, Plus, etc)

4. And we would be pleased to send you out a temporary
subscription Key to apply to your database so that you
may fully trial before purchase of the QBOI subscription

d. It is recommended BEFORE running QBOI for the first time, that you
have the following already created in the appropriate database (as selected
in your QBOI Preferences and as are selected when you perform your
importing):

· Whether importing your QB Online data (customers, Items, etc) into
your AyaNova database OR whether importing your AyaNova data
(Clients, Parts, etc) into your QB Online database:
o A QB Online non-inventory item for AyaNova Loan charges
o A QB Online service for AyaNova Outside Service charges
o A QB Online non-inventory item for Misc Expenses

· When importing your AyaNova data (Clients, Parts, etc) into your
empty QB Online database:
o Your QB Online Tax Codes
o Your QB Online COGS account(s)
o Your QB Online Inventory account(s)
o Your QB Online Asset account(s)

mailto:support@ayanova.com
mailto:support@ayanova.com
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· When importing your QB Online data (customers, Items, etc) into
your AyaNova database:
o Erase the AyaNova sample data before entering any data you want

to keep in your AyaNova database
o At minimum two Workorder Statuses -  one Workorder Status that

would be selected to indicate workorder is ready for invoicing, and
another for when workorder has been invoiced via QBOI into your
QB Online

2. Install AyaNova and QBOI via the AyaNova installation file.

a. If AyaNova was previously installed, make sure to have exited out of the
AyaNova program before proceeding.
i. No worries - running the AyaNova setup again does not overwrite your

stand-alone database, it will only overwrite the program files.
ii. Refer to the AyaNova installation steps in the AyaNova Help file for

installing AyaNova either for single stand-alone use or for networked
use if you require additional assistance.

b. Run the AyaNova installation file AyaNovaSetup.exe, and select QBOI
where indicated to install to your local hard drive

https://www.ayanova.com/onlinehelp.htm
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c. When asked if you want to overwrite the config.txt, select No. 
i. The config.txt file tells your AyaNova program and your QBOI where to

find your AyaNova database.
ii. If you do accidentally select Yes, the default config.txt for default

stand-alone single use will replace your existing.  

d. The QBOI program files will be installed to C:\Program Files (x86)\Ground
Zero Tech-Works Inc\AyaNova\plugins\QBOI
i. NOTE: If just recently upgraded from an older version of AyaNova,

you will also see a new file named AyaNova.exe.config that is utilized
by QBOI and other AyaNova related programs going forward. Do not
edit this file unless directed so by AyaNova Support.

· NOTE: if you get a message such as below about replacing a file, this is
because an AyaNova program is still running.
o Click Abort
o And then check to make sure you do NOT have the AyaNova program

running
o Check you do not have any of the import/export utilities running
o Check Services to make sure that the AyaNova Generator is shut off

while installing
o Check your IIS and shut down the Default Web Site and AyaNovaDP

(the data portal) if installed. 
o Then follow the steps again.
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3. Now onto Starting QBOI for the first time.
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2.3 Starting QBOI for the first time

If this is the first time running QBOI on this computer, and/or if all steps
below have not been completed successfully, follow below:

1. Confirm installation has been completed on this computer.

2. Log into AyaNova as a user that has at minimum Read/Write/Delete rights in
their security group to the following:

· Object.Client
· Object.Part
· Object.Rate
· Object.Vendor
· Object.Workorder
· Object.WorkorderService

3. Log into your QB Online company database on this same computer

§ It is suggested that BEFORE running QBOI for the first time, that you
have the following already created in your QB Online database
(whether you will be importing AyaNova data to your QB Online or
importing QB Online data to your AyaNova) so that when you set your
Preferences, these objects are already there to select:

o Your QB Online Sales Tax Codes
§ depending on your country version of AyaNova, as may need to be

selected when importing AyaNova clients and/or parts into your QB
Online database

o A QB Online non-inventory item for AyaNova Loan charges
o A QB Online service for AyaNova Outside Service charges
o A QB Online non-inventory item for Misc Expenses

§ No worries if these were not set before the first time you loaded QBOI, as
you can always go back and edit your Preferences with the correct QB
Online selections you want to use after completing these initial steps that
follow.

4. Start the QBOI program from within the AyaNova desktop program from the
Plug-Ins menu at the very top
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5.a Your default web browser will launch a temporary "web server" which
redirects to trigger the authentication process of authenticating use of your
desktop QBOI with your QuickBooks Online

Don't worry, please be patient -  there may be a slight delay depending on
QB Online itself -  could be even as much as 2 minutes.

Until your QB Online login web page displays, you will also notice that
AyaNova in the background will show (Not responding) - that too is expected
until the QB Online authentication process has completed.

Log in.

5.b If this is your first time logging in via AyaNova's QBOI, you will be asked to
confirm this is OK by having a code sent to your email account from QB Online
that you will input.

Then click to Continue, authorizing QBOI to access your QB Online data.
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5.c If you have multiple QB Online databases, select the specific database that
you will always be using with your AyaNova.

Attempting to use different QB Online databases with a single AyaNova
database will lead to broken links between mapped data, issues with
Preferences, and other possible issues.
Always select to use the same QB Online database. 
QBOI will also have you reconfirm which QB Online database by its QB
Online database name you gave it in QB Online too. 

Example below of multiple database selection
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6.a You will be asked to authorize sharing of your data between AyaNova_QBOI
and Intuit

6.b Click on Authorize to continue.

6.c You can now close this  "web server" tab/web page as now authorized with a
token. This web page does not have to remain open. The authorization token will
remain until you exit out of AyaNova itself (just exiting out of QBOI will not
remove the token).

7. If this is the first time running QBOI after having authorized the connection,
you will now be prompted by QBOI that the next step is to set up your QBOI
Preferences.

Don't worry, you can always edit your Preferences again at a later time if you
decide you instead want different AyaNova or QB Online items selected.
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8. Is the name listed the correct QB Online database file you want to use with your
AyaNova and QBOI?

If this is the correct QB Online company database, click on the green OK button
to accept.

If this is not correct, click on the orange Cancel button to cancel. 
Log out of the QB Online database file you were in.
Exit out of AyaNova, and start the process again, being sure to select the
correct QB Online company file you want to interface with your AyaNova

9. Now Preferences will be set. 

The first will be to set the AyaNova Workorder Status of the billable
workorder. 

QBOI displays workorders that are ready for billing based on a number of
factors - one being this specific Workorder Status set here.
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If you do not presently have an AyaNova Workorder Status set up that you
want to use for this, just select any status for now. As after you have
completed these initial Preferences settings and setup, you can at any time
afterward go into your AyaNova, create a new Workorder Status, refresh your
QB Online connection and then edit your QBOI Preferences again.

     
<note that AyaNova Workorder Status selected in screenshot above is only an
example, select what YOU want to use>

 

10. As the information on the window states, the next Preference to set will be the
AyaNova Workorder Status you want the workorder to be set to once invoiced. 

Doing so will allow you to easily filter workorders in your AyaNova as to which
have already been invoiced through your QBOI.

If you do not presently have an AyaNova Workorder Status set up that you
want to use for this, just select any status for now. As after you have
completed these initial Preferences settings and setup, you can at any time
afterward go into your AyaNova, create a new Workorder Status, refresh your
QB Online connection and then edit your QBOI Preferences again.
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<note that AyaNova Workorder Status selected in screenshot above is only an
example, select what YOU want to use>

 
11. As the information on the window states, the next Preference to set will be the
QB Online item to use when billing Outside Service.

This is a mandatory and required selection - you MUST select a QB Online
item.

If you do not presently have a QB Online item set up for charging Outside
Service, just select any item for now. As after you have completed these initial
Preferences settings and setup, you can afterward in your QB Online company,
create a new specific item for this, refresh your QB Online connection and then
edit your QBOI Preferences again.

 
12. As the information on the window states, the next Preference to set will be to
select the QB Online item to use when invoicing miscellaneous expenses in a
service workorder item.
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This is a mandatory and required selection - you MUST select a QB Online
item.

If you do not presently have a QB Online item set up for charging
Miscellaneous expenses, just select any item for now. As after you have
completed these initial Preferences settings and setup, you can afterward in
your QB Online company, create a new specific item for this, refresh your QB
Online connection and then edit your QBOI Preferences again.

     
 
13. As the information on the window states, the next Preference to set will be to
select the QB Online item to use when invoicing loan charges in a service
workorder item.

This is a mandatory and required selection - you MUST select a QB Online item

If you do not presently have a QB Online item set up for charging for
Workorder loans, just select any item for now. As after you have completed
these initial Preferences settings and setup, you can afterward in your QB
Online company, create a new specific item for this, refresh your QB Online
connection and then edit your QBOI Preferences again.
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14. As the information on the window states, the next Preference to set will be to
select the QB Online transaction class if used.

This is optional.

 
 
15.  As the information on the window states, the next Preference to set will be to
select the Default Terms you want QBOI to tell your QB Online data to set the
imported customer record(s) to when imported from AyaNova to your QB Online
data

 
16. As the information on the window states, the next Preference to set will be
either uncheck or leave check-marked the To Be Printed in a QuickBooks invoice
that is created.
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17. As the information on the window states, the next Preference to set will be
either uncheck or leave check-marked to to have invoices generated to be
checkmarked To be emailed/send later

 
18. QB Online has two memo fields for an invoice:

1. The Customer Memo field which will show on the invoice that the
customer sees.
2. And  a private message field called the  "Statement Memo" field where
internal notes are not seen by the customer. 

If this Preference is checkmarked:
1. The Customer Memo field will display the AyaNova workorder number
that the billable items were generated from via QBOI
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2. The private message field will display the name of the logged in
AyaNova user and the date generated.

If this Preference is not checkmarked:
1. The Customer Memo field will not have any QBOI generated info added.
2. The private message field will not have any QBOI generated info added.

19. As the information in the window states, either un-check or leave check-
marked to have the AyaNova workorder set to the Closed state once the workorder
has been invoiced via QBI into QuickBooks.

An AyaNova service workorder set to the Closed state can not be edited further
nor deleted.
For more information on the Closed state (and how to undo if needed), refer to
your AyaNova online Help documentation regarding that specific section of the
AyaNova workorder.
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20. Now select to run QBOI Main

21. QBOI will now jump you to its Map & Import section so you can map (the
words "map" and "link" are used interchangeably and are meant as the same)
existing data between your QB Online and your AyaNova, and then import data
from your QB Online to your AyaNova and/or AyaNova to your QB Online
database.

Review about mapping (linking), how to manually map (link), how to
automatically map (link) and more. 

It is recommended that you first map (link) data that exists already in both
your QB Online database and your AyaNova database before importing. 

Review about importing your QB Online data into your AyaNova database, and
how to.
Review about importing your AyaNova data into your QuickBooks database, and
how to.
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2.4 Starting QBOI from then on

NOTE the below is based on that you have successfully completed Starting QBOI
for the first time 
If you have not, go back and do so FIRST.

1. Your QBOI Main may already be running - hover your mouse over your
AyaNova icon on your Windows task bar like that shown in the example
screenshots below and select QBOI if listed as already running

2. Or if not running, start AyaNova QBOI from within the AyaNova desktop
program from the Plug-Ins menu at the very top

3.a If your computer is still authenticated with your QB Online 
· have not exited or logged out of AyaNova since the last time you

authenticated with your QB Online; 
· your computer has not been idle for a length of time which can as a result

disconnect your Intuit connection;
· QB Online has not lost its connection to your computer
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then you will be presented as per below - select to run QBOI Main

It is always suggested to Refresh your QB connection, especially if anyone else is
working in either AyaNova or QB at the same time as you are, and/or if you have
made any edits in either.

Now proceed with editing your Preferences if needed, mapping/linking if needed,
importing if needed, editing your Descriptive Text if needed, and/or invoicing if
needed.

3.b  Whereas if your authentication has been lost, you will be asked
again to authorize sharing of your data between AyaNova_QBOI and your
QB Online data.

This is for your security and required by Intuit (QB Online).

3.b.1. Your default web browser will again launch a temporary "web server"
which redirects to trigger the authentication process of authenticating use of
your desktop QBOI with your QuickBooks Online

Don't worry, please be patient -  there may be a slight delay depending on
QB Online itself -  could be even as much as 2 minutes.

Until your QB Online login web page displays, you will also notice that
AyaNova in the background will show (Not responding) - that too is expected
until the QB Online authentication process has completed.

Log in.

3.b.2.  Click on Authorize to continue.
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3.b.3.  And once you receive the Success page You can now close this  "web
server" tab/web page as now authorized with a token. This web page does not
have to remain open. The authorization token will remain until you exit out of
AyaNova itself (note that just exiting out of QBOI will not remove the token).

3.b.4.  And again, if you have multiple QB Online databases, again you will
need to select the same QB Online database you did with which you have
already mapped/linked and imported data.
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3.b.5.  And again, is the name listed the correct QB Online database file you
want to use with your AyaNova and QBOI?

If yes, click on the green OK button to accept.

If this is not correct, click on the orange Cancel button to cancel. 
Log out of the QB Online database file you were in.
Exit out of AyaNova, and start the process again, being sure to select the
correct QB Online company file you want to interface with your AyaNova

3.b.6. Now select to run QBOI Main

Now proceed with what needed done - i.e.  editing your Preferences if needed,
with mapping/linking existing data if needed, importing your QB Online
clients/items/vendors into AyaNova if needed, importing your AyaNova
clients/vendors/parts/rates into your QB Online if needed, editing your Descriptive
Text if needed, and/or invoicing if needed.
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2.5 Editing QBOI Preferences

The following assumes you have started QBOI

Edit your Preferences from the menu option Tools -> Preferences. 

1. First QBOI will ask you to re-confirm this is the correct QB Online database
you want to work with. 

If yes, click on the green OK button to accept.

If this is not correct, click on the orange Cancel button to cancel. 
Log out of the QB Online database file you were in.
Exit out of AyaNova, and start the process again, being sure to select the
correct QB Online company file you want to interface with your AyaNova

2. The first displayed Preference will be to set the AyaNova Workorder Status of
the billable workorder. 

Your QBOI Main window displays workorders that are ready for billing based
on a number of factors - one factor being this specific Workorder Status set
here.

If you do not presently have an AyaNova Workorder Status set up that you
want to use for this, just select any status for now. As after you have
completed these initial Preferences settings and setup, you can at any time
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afterward go into your AyaNova, create a new Workorder Status, refresh your
QB Online connection and then edit your QBOI Preferences again.

     
<note that AyaNova Workorder Status selected in screenshot above is only an
example, select what YOU want to use>

 

3. As the information on the window states, the next Preference to set will be the
AyaNova Workorder Status you want the workorder to be set to once invoiced. 

Doing so will allow you to easily filter workorders in your AyaNova as to which
have already been invoiced through your QBOI.

If you do not presently have an AyaNova Workorder Status set up that you
want to use for this, just select any status for now. As after you have
completed these initial Preferences settings and setup, you can at any time
afterward go into your AyaNova, create a new Workorder Status, refresh your
QB Online connection and then edit your QBOI Preferences again.
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<note that AyaNova Workorder Status selected in screenshot above is only an
example, select what YOU want to use>

 
4. As the information on the window states, the next Preference to set will be the
QB Online item to use when billing Outside Service.

This is a mandatory and required selection - you MUST select a QB Online
item.

If you do not presently have a QB Online item set up for charging Outside
Service, just select any item for now. As after you have completed these initial
Preferences settings and setup, you can afterward in your QB Online company,
create a new specific item for this, refresh your QB Online connection and then
edit your QBOI Preferences again.

 
5. As the information on the window states, the next Preference to set will be to
select the QB Online item to use when invoicing miscellaneous expenses in a
service workorder item.
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This is a mandatory and required selection - you MUST select a QB Online
item.

If you do not presently have a QB Online item set up for charging
Miscellaneous expenses, just select any item for now. As after you have
completed these initial Preferences settings and setup, you can afterward in
your QB Online company, create a new specific item for this, refresh your QB
Online connection and then edit your QBOI Preferences again.

     
 
6. As the information on the window states, the next Preference to set will be to
select the QB Online item to use when invoicing loan charges in a service
workorder item.

This is a mandatory and required selection - you MUST select a QB Online item

If you do not presently have a QB Online item set up for charging for
Workorder loans, just select any item for now. As after you have completed
these initial Preferences settings and setup, you can afterward in your QB
Online company, create a new specific item for this, refresh your QB Online
connection and then edit your QBOI Preferences again.
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7. As the information on the window states, the next Preference to set will be to
select the QB Online transaction class if used.

This is optional.

 
 
8.  As the information on the window states, the next Preference to set will be to
select the Default Terms you want QBOI to tell your QB Online data to set the
imported customer record(s) to when imported from AyaNova to your QB Online
data

 
9. As the information on the window states, the next Preference to set will be
either uncheck or leave check-marked the To Be Printed in a QuickBooks invoice
that is created.
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10. As the information on the window states, the next Preference to set will be
either uncheck or leave check-marked to to have invoices generated to be
checkmarked To be emailed/send later

 
11. QB Online has two memo fields for an invoice:

1. The Customer Memo field which will show on the invoice that the
customer sees.
2. And  a private message field called the  "Statement Memo" field where
internal notes are not seen by the customer. 

If this Preference is checkmarked:
1. The Customer Memo field will display the AyaNova workorder number
that the billable items were generated from via QBOI
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2. The private message field will display the name of the logged in
AyaNova user and the date generated.

If this Preference is not checkmarked:
1. The Customer Memo field will not have any QBOI generated info added.
2. The private message field will not have any QBOI generated info added.

12. As the information in the window states, either un-check or leave check-
marked to have the AyaNova workorder set to the Closed state once the workorder
has been invoiced via QBI into QuickBooks.

An AyaNova service workorder set to the Closed state can not be edited further
nor deleted.
For more information on the Closed state (and how to undo if needed), refer to
your AyaNova online Help documentation regarding that specific section of the
AyaNova workorder.
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13. And then you will be returned to the QBOI Main window

Now proceed with mapping/linking existing data if needed, importing your QB
Online clients/items/vendors into AyaNova if needed, importing your AyaNova
clients/vendors/parts/rates into your QB Online if needed, editing your
Descriptive Text if needed, and/or invoicing if needed.
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2.6 Refreshing your QBOI connection

QBOI displays what is present in your AyaNova and in your QB Online at the time
QBOI was first loaded or when was last refreshed.

So if you or anyone else edits/deletes/adds data to either your AyaNova data or
your QB Online data, you will not see until you refresh the connection between the
two databases.  QBOI itself does not save any information, QBOI is the interface
between your two databases - your AyaNova database data and your QB Online
data.

Such as workorders that are ready to be invoiced, an edited Customer record, a
deleted Part, etc.

If you are not seeing something you expect to, Refresh!

4 ways to refresh your connection:

1. Select to Refresh QuickBooks Online connection from the main AyaNova
window

2. From within QBOI Main menu Tools, select Refresh QuickBooks Online
connection

3. If not seeing AyaNova service workorders that are ready for invoicing, from
QBOI's menu Invoices select Refresh invoices
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4. Exit out of your QBOI AND exit out your AyaNova, log into your AyaNova and
start again

NOTE:  The menu options regarding refreshing from your AyaNova's Clients
grid or client record Plugins menu, or your AyaNova's Parts grid or part record is
NOT the same as refreshing your QB Online connection.

These refer instead to updating existing mapped(linked) client records or
updating existing mapped(linked) part records with the existing QB Online
connection. Not the same thing as refreshing the actual QB Online connection.



Mapping & Importing
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3 Mapping & Importing

3.1 Mapping (linking)

3.1.1 What is Mapping (linking)?

Mapping existing data is when you have the object (may also be referred to as
"record") already in both your AyaNova database and in your QB Online database,
so you wish to link/map  (the words map and link are used interchangeably)  the
two objects together without actually changing the data in either your AyaNova
database nor your QB Online database.

· NOTE: Mapping/linking objects does not update information from one object
to the other - mapping only links the  existing QuickBooks Online record to the
existing AyaNova record for use so that your QB Online knows what to bill out
to match the billable charges in your ready-to-be invoiced AyaNova workorder. 

· If you want to update the data of one with the data of the other, refer to
Update Mapped/Imported Parts and/or Update Mapped/Imported Clients

What does a linked (mapped) AyaNova and QB Online object look like in
your QB Online Main
Examples of situations when you would use the manual link feature of
QBOI
Example of a situation when you would use the Auto-link feature of QBOI

What does a linked (mapped) AyaNova and QB Online object look like in
your QB Online Main:

The object will show a link symbol  next to it when viewed via your
QBOI Main -> click on Tools menu -> Map & Import -> select the specific type
of object (Clients, Parts, Services, Vendors)

This link may be a result of manually linking one or more existing AyaNova
objects to a single QB Online object, or a single QB Online object to a single
AyaNova object.
OR this link may be the result of auto-linking existing AyaNova object with an
existing QB Online object with the same name/number (depending on the
object)
OR this link may be a result of importing the AyaNova object into your QB
Online database.
OR this link may be a result of importing the QB Online object into your
AyaNova database.



61

AyaNova QBOI Help 
 
                                                                                                                                                                                                                   © 1999 - 2018 Ground Zero Tech-Works Inc

Mapping & Importing

Below shows example of the information from clicking on an AyaNova object:
NOTE: A single AyaNova object can only be linked to a single QB Online
object.

Below shows example of the information from clicking on an QuickBooks
Online object:
NOTE: A single QB Online object can be linked to one or more AyaNova
objects. 
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Examples of situations when you would use the manual link feature of
QBOI is:

1. Existing clients in AyaNova are actually billed to a head office that is
entered in QuickBooks Online

· So you would want multiple AyaNova clients mapped (linked) linked
to one QuickBooks Online customer (which is the one office that all
these AyaNova clients get their invoices sent to).

2. You have manually entered some data in AyaNova that does not have
the exact same name as the name in QuickBooks Online

·  So the automatic link Auto-Link feature would not work
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3. You want full control over what existing AyaNova data is linked to what
existing data in QuickBooks Online

·  So you want to manually map (link) each QuickBooks Online object
to each AyaNova object

Examples of a situation when you would use the Auto-link feature of
QBOI is:

1. You have manually entered some data in AyaNova that does have the
exact same name as the name in QuickBooks Online

3.1.2 How to manually link existing data

To manually link a single AyaNova object to a QB Online object
To manually link multiple AyaNova objects to a single QB Online object

To manually link (map) a single AyaNova object to a QB Online object 

Basically, the steps are to select the AyaNova object and drag to the specific
QB Online object

1. If not already viewing the Map & Import screen select the menu Tools ->
Map & Import from the main QBOI screen

2. Select what type of object you wish to map & import by selecting the menu
Object  <In the following screenshot we have selected to map & import
Clients>
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3. Find on the AyaNova side the AyaNova object you want to link, and find on
the QuickBooks Online side the QuickBooks Online object you want to link.
<in this example its the AyaNova client Billy Bob's Crqab Shack Co  and
the QB Online customer Billy Bob's Crqab Shack as the names are not
exactly the same, Auto-link won't apply  in this situation>

 

4. Click and hold down on the indicator (the square to the left of the
AyaNova object's name) <you will note that the object indicator now
shows an arrow within it>

 

5. Now drag it to the QuickBooks Online object and release overtop of the
QuickBooks Online object  <you will note your cursor changes to a

 while dragging it>
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6. QBOI will pop up a window to confirm this is the QuickBooks Online object
you wish to link this AyaNova object with

 

7. Now the two objects will show the linked symbol 

To manually link multiple AyaNova objects to a single QB Online object



66

AyaNova QBOI Help 
 
                                                                                                                                                                                                                   © 1999 - 2018 Ground Zero Tech-Works Inc

Mapping & Importing

Examples when would link multiple AyaNova objects to a single QB Online
object would be when:
· a single QB Online client is billed for multiple AyaNova clients
· a single QB Online part is billed in the QB Online invoice for different

AyaNova parts

1. Select multiple continuously listed AyaNova objects at one time by

clicking on the first item's object indicator   , holding down the SHIFT

key on your keyboard and selecting the last item's object indicator 
(or select non-continuous listed AyaNova objects by holding down the
CTRL key while selecting each object's indicator)

2. Than drag all at the same time to the QB Online object you want them
all to link to.

3. Confirm OK
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4. Now if you select that QB Online object, it will show all AyaNova
objects linked to it

NOTE: QBOI only obtains QuickBooks Online and AyaNova information when
QBOI first loads
If you enter new information into either QuickBooks Online or AyaNova with QBOI
running, you need to refresh the connections in 4 possible ways
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3.1.3 How to automatically link existing data

Two examples of when you could/would use the automatic link (map)
feature of QBOI:

Example 1. You previously used a desktop version of QuickBooks that you
moved to QB Online, and was using AyaNova version 6.1 (which did not have
a QBOI interface)

· You have now purchased the subscription for QBOI and for your
AyaNova level of scheduleable users, and upgraded to the latest
AyaNova program version (which also updated your database)

· Now you need to link the previously imported and linked AyaNova
data to that of your QB Online company data file again for use via
QBOI.

Example 2. You had manually entered in clients, parts, rates, vendors with
the same name/number into your AyaNova database as that in your
QuickBooks Online

·  Automatic linking will compare names of each object and link that
which it most believes is correct.

The automatic link does not update information from one object to the other
- it links the two objects only.

The automatic link feature compares the QB Online object name to that of a
corresponding AyaNova object.

The automatic link does not compare other fields of information for the
object - only the name (or in the case of a AyaNova Part, the Part
Number). 

Use the appropriate update steps whether updating older linked QB Online
data, or updating older linked AyaNova data

The fields that are compared during Auto-Link

The automatic link feature will compare the following field of data between
the two objects and than automatically link if they are the same:

QuickBooks Online customer entry AyaNova client entry
Company Name Client Name

QuickBooks Online vendor entry AyaNova vendor entry
Vendor Name Vendor Name
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QuickBooks Online Item entry AyaNova Part entry
Item Name/Number Part Number

QuickBooks Online Item entry AyaNova Rate entry
Item Name/Number Rate Name

To automatically link AyaNova objects with QuickBooks Online objects of
the same name is just selecting the Auto Link menu option:

1. If not already viewing the Map & Import screen select the menu Tools ->
Map & Import from the QBOI main screen

2. Select what type of object you wish to map & import by selecting the menu
Object  <In the following screenshot we have selected to map & import
Clients>

3. Select the menu option Auto Link

     

4. AyaNova objects now linked will display the link symbol 
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NOTE: QBOI only obtains QuickBooks Online and AyaNova information when
QBOI first loads
If you enter new information into either QuickBooks Online or AyaNova with QBOI
running, you need to refresh the connections in 4 possible ways

3.1.4 How to unlink (unmap)

Unlink (unmap) can be done either via the linked AyaNova object or via the linked
QuickBooks Online object.

· It is not possible to unlink (unmap) multiple objects at once. 
· Each object must be unlinked individually manually. 

Unlink by the linked AyaNova object
Unlink by the linked QB Online object

Unlink by the linked AyaNova object:

1. Select the linked AyaNova object to display the information on the QB
Online object linked to
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2. Select the Unlink button to unlink the two objects from each other 

3. Select Yes to unlink
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4. Dialogue window will display that this AyaNova object is NOT linked to any
QB Online object. 

5. Select OK to exit out of.

Unlink by the linked QuickBooks Online object:

As it is possible to have multiple AyaNova objects linked to a single QB Online
object, the unlink steps are slightly different.

1. Select the linked QB Online object to display the information on the
AyaNova object linked to
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Note it is also possible to have multiple AyaNova objects linked to a single QB Online object

3. Uncheck the checkmark under the link symbol for the AyaNova object you no
longer want linked to this QB Online object
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4. Click on OK 

5. Now shows unlinked between the two objects
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3.1.5 If delete or remove linked items in QuickBooks

Every time once you load QBOI and authenticate to your QB Online database and
every time you Refresh QBOI connection, QBOI will run a pre-flight check:

· to confirm all required Preferences have been set
· to confirm that Preferences that were previously set are still valid (i.e. the

object is still active and available)
· to obtain a cache of your QB Online data and your AyaNova data to display in

your Map & Import
· to confirm that objects that were previously linked are still valid (i.e. the

object is still active and available)

If QBOI identifies that object selected in your Preferences is no longer active or
available, you will be presented with notification of this such as example below:

· This may be an indication that you have connected to a different QB Online
database then you used before.

· This may be an indication that the QB Online item has been set to inactive

If QBOI identifies that previously linked object is missing or set to inactive, you
will be presented with options as per the example below: 
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If this message is unexpected, it would be recommended to select Cancel so that
QBOI will shut down. Then exit out of your AyaNova, and check the following:

· This may be an indication that you have connected to a different QB Online
database then you used before.

· This may be an indication that the QB Online item has been set to inactive

QBOI will prompt each unlinked or missing QuickBooks Online object one by
one, identifying if the item's "item name" is missing or set to Inactive in
QuickBooks Online and confirming if you want to remove the link. 

QBOI will prompt Yes, No or Cancel.

· If you select Yes the item will be unlinked - examples of use are items that have
been set to inactive on purpose

· If you select No QBOI will go on to the next mismatch in the list if any. NOTE
that if you select No, QBOI will end up displaying data that may be
incorrect.

· If you select Cancel QBOI will abort the startup and shut down itself. Exit out of
AyaNova. Log into AyaNova and start again.
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3.2 How to import QuickBooks data into AyaNova

3.2.1 Why would I want to import my QB Online data into my AyaNova database?

Why would I import QB Online data into my AyaNova database?

· Importing your QB Online data into your AyaNova database automatically links
the data between your two databases (your AyaNova database and your QB
Online database) via QBOI so that the workorder's AyaNova customer and its
billable charges (i.e. parts and qty, service rate and qty) are linked to the
correctly linked QB Online customer and its billable charges (i.e. inventory
items, non-inventory items, )

· And by having these linked via QBOI, you can also easily and quickly update
existing information from one database to the other (i.e. update information
about a customer's address that you had edited in AyaNova into your QB Online
database; or update information about an inventory item you had edited in QB
Online and now want in your AyaNova database)

· If you are starting with a new empty AyaNova database, save yourself time by
importing your QB Online data.

· Importing your existing  QB Online data into your AyaNova database saves
you time - no need to manually create the same record in your AyaNova
database.

· If you have just finished configuring QBOI for the first time, after the following
message QBOI will open to the Map/Import screen defaulting to the Clients
objects.

This is an example screenshot only - you may have data on your AyaNova side and/or you will
have different data on your QuickBooks side
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· Or if at any time you need to link existing AyaNova objects with existing QB
Online objects at any time, select the menu Tools, than Map and import to
open the Map/Import screen - defaults to the Client Object selected,  showing
the AyaNova clients on the left and QuickBooks Online customers on the right. 

· Select the menu Object to drop down to select other objects you want to link
and/or import

3.2.2 Import via QBOI Main - customers, items, services, vendors

Minimum AyaNova data to have been created before map/importing your
QB Online data into your AyaNova
Basic steps to import a single object into your AyaNova database
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Basic steps to import multiple objects of the same type into your
AyaNova database
· Using SHIFT while selecting the first and last object listed

continuously
· Using CTRL while selecting non-continuously listed objects

Minimum AyaNova data to have been created before map/importing your
QB Online data into your AyaNova

· Erase the existing sample and testing data in your AyaNova database 

· Create at minimum two Workorder Statuses - one Workorder Status that would
be selected to indicate workorder is ready for invoicing, and another for when
workorder has been invoiced via QBOI into your QB Online so can be selected in
your Preferences

· Create your AyaNova Tax Codes - QBOI is not able to import your existing QB
Online tax codes into AyaNova

· Set your AyaNova Global Settings

· Follow along with the rest of the suggestion order of setting up your AyaNova

Basic steps to import a single object into your AyaNova database

1. Click and hold down on the object indicator (the square to the left of the
AyaNova client or vendor)  <you will note that the object indicator now shows
an arrow within it>

https://www.ayanova.com/AyaNova7webHelp/index.html?erase_the_ayanova_database.htm
https://www.ayanova.com/AyaNova7webHelp/index.html?tax_codes.htm
https://www.ayanova.com/AyaNova7webHelp/index.html?business_settings.htm
https://www.ayanova.com/AyaNova7webHelp/index.html?suggested_order_of_setting_up_.htm
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2. Now drag it to the Drop here to import AyaNova item(s) <you will note

that your cursor changes to a  while being dragged>

3. Release over the Drop here to import AyaNova item(s) and confirmation
that you want to import will display.
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4. And then the imported AyaNova object will display on the AyaNova "side"

along with the linked symbol  just like that shown in How to manually
link existing data

Basic steps to import multiple objects of the same type into your
AyaNova database

Two ways: 
· 1st using SHIFT if selecting continuous list of objects; 
· 2nd using CTRL if selecting non-continuous objects in list

1st method using SHIFT if selecting continuous list of objects

1. Select the first QuickBooks Online item and than holding the SHIFT key when
you select the last QB Online object in a continuous list<note how all from the
first selected to the last are highlighted> . 
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2. Now drag it to the Drop here to import QuickBooks item(s) <you will

note that your cursor changes to a  while being dragged>

3. Release over the Drop here to import QuickBooks item(s) and
confirmation that you want to import will display.

4. And then the imported AyaNova object(s) will display on the AyaNova "side"

along with the linked symbol  just like that shown in How to manually
link existing data

2nd method using CTRL if selecting non-continuous objects in list

1. Select the first QuickBooks Online item,  hold the CTRL key and select each
additional QB Online items <note how only the items selected are
highlighted> . 
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2. Now drag it to the Drop here to import Quickbooks item(s) <you will

note that your cursor changes to a  while being dragged>

3. Release over the Drop here to import QuickBooks item(s) and
confirmation that you want to import will display.
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4. And then the imported AyaNova object(s) will display on the AyaNova "side"

along with the linked symbol  just like that shown in How to manually
link existing data

NOTE: QBOI only obtains QuickBooks Online and AyaNova information when
QBOI first loads
If you enter new information into either QuickBooks Online or AyaNova with QBOI
running, you need to refresh the connections

3.2.3 QuickBooks customers data that is imported into AyaNova

When importing your QB Online customer data into your AyaNova database using
QBOI, the following identifies the specifics fields of data that will be imported into
the AyaNova client from a QuickBooks Online customer:

· If a field is not listed here as imported, than that QB Online field's data is not
imported into the AyaNova object. 

· As Intuit makes more fields available for importing, we hope to add more fields
imported. Let us know which in particular and we will certainly check to see if has
been made available!

Note the following:

· It is expectyed that QBOI will import all lines from the QB Online customer
record first Address field into the Street field of an AyaNova client record
Address (be it Billing to Postal or Shipping to Physical). So if your QB Online
address field includes the customer's name, that too will be imported into the
Street field in your AyaNova. 

· QuickBooks Online Tax Codes are not importable into AyaNova.  An invoice in
QuickBooks Online created by QBOI uses the tax codes set up for the
QuickBooks Online object (i.e. client or the part depending on your country
version of QB Online) - QBOI does not transfer nor do anything with the tax
code selected in the AyaNova service workorder.
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The fields of data that are imported from a QB Online Customer object to
an AyaNova Client object are:

QB Online customer AyaNova client

1. Display Name as Client Name
2. Email Email
3. Phone Business
4. Fax Fax
5. Other Home
6. Shipping Address Physical Address
6a. Street
6b. City
6c. State or Province
6d. Postal / Zip code
6e. Country
7. Billing Address Postal Address
7a. Street
7b. City
7c. State or Province
7d. Postal / Zip code
7e. Country

QuickBooks Online client fields identified:
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AyaNova client fields identified:
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3.2.4 QuickBooks vendors data imported into AyaNova

When importing your QB Online vendor data into your AyaNova database using
QBOI, the following identifies the specifics fields of data that will be imported into
the AyaNova vendor from a QuickBooks Online vendor:

· If a field is not listed here as imported, than that QB Online field's data is not
imported into the AyaNova object. 

· As Intuit makes more fields available for importing, we hope to add more fields
imported. Let us know which in particular and we will certainly check to see if has
been made available!

NOTE the following 3 important aspects of importing your QB vendor: 

· The AyaNova vendor type set in the imported AyaNova vendor entry screen is
dependent on the QBOI Main object vendor type selected before importing

For example: if you want the QB Online vendor imported to be set as a
Wholesaler in AyaNova, you would select Object - > Vendors ->
Wholesaler
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The fields of data that are imported from a QuickBooks Online Vendor
object to an AyaNova Vendor object are:

QuickBooks Online vendor AyaNova vendor

1. Display Name As Vendor Name
2. Account No. Account Number
3. Email Email
4. Phone Business

5. Fax Fax
6. Other Home
7. Address Postal Address
7a. Street
7b. City
7c. State or Province
7d. Postal / Zipcode
7e. Country
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QuickBooks Online vendor fields identified:

AyaNova vendor fields identified:
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3.2.5 QuickBooks Items (Inventory or Non-inventory) data imported into AyaNova

When importing your QB Online Item (Inventory Item or Non-inventory Item) data
into your AyaNova database using QBOI, the following identifies the specifics fields
of data that will be imported into the AyaNova Part from a QuickBooks Online Item
(Inventory Item or Non-inventory Item):

· If a field is not listed here as imported, than that QB Online field's data is not
imported into the AyaNova object. 

· As Intuit makes more fields available for importing, we hope to add more fields
imported. Let us know which in particular and we will certainly check to see if has
been made available!

NOTE: QBOI does not import your QB Online Item's Quantity On Hand nor its
Reorder Point. 
· If you want to track On Hand amounts in your AyaNova as well as in your QB

Online version that supports Inventory Items, once imported into your
AyaNova, then perform Part Adjustments for opening inventory for all parts
as per the AyaNova tutorial

· If you do NOT want to track On Hand amounts in your AyaNova, nor any
other inventory related features (i.e. Part Requests, Purchase Orders) then
turn off your inventory in your AyaNova via your Global Settings

NOTE: Before QBOI Main will complete the import of your selected QB Online
Item(s) into your AyaNova, QBOI will ask you to either <DO NOT SET
VENDOR> in the imported AyaNova part(s) OR to select a specific existing
AyaNova Wholesaler.

https://www.ayanova.com/AyaNova7webHelp/index.html?enter_opening_inventory.htm
https://www.ayanova.com/AyaNova7webHelp/index.html?enter_opening_inventory.htm
https://www.ayanova.com/AyaNova7webHelp/index.html?use_inventory_-_global.htm
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You WILL want to select an existing AyaNova wholesaler if you plan on
using AyaNova's inventory features such as Part Requests, Purchase Orders, etc.

For example: 
Your QBOI Main Tools -> Map & Import -> Objects -> Vendors -> Wholesalers
looks like:

So every time you select one or more QB Online Item(s) to import using Tools
-> Map & Import -> Objects -> Parts, QBOI will display for selection the
available AyaNova Wholesalers whether linked via QBOI or not.

The fields of data that are imported from a QuickBooks Online Item (of
type Inventory or Non-inventory) object to an AyaNova Part object are:

QuickBooks Online Item AyaNova part

1 Item Name/Number Part Number
2 Description on Sales Transactions Part Name
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3 Sales Price Retail Charge
4 Cost Cost
5 Wholesaler (*only if selected at time
of QBOI import)

QuickBooks Online Item (inventory) fields identified:
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AyaNova Part fields identified:
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3.2.6 QuickBooks Items (Service) data imported into AyaNova

When importing your QB Online Item (Service or Other Charges) data into your
AyaNova database via QBOI, the following identifies the specifics fields of data that
will be imported into the AyaNova rate (Service Rate or Travel Rate) from a
QuickBooks Online Item (Service or Other Charges):

· If a field is not listed here as imported, than that QB Online field's data is not
imported into the AyaNova object. 

· As Intuit makes more fields available for importing, we hope to add more fields
imported. Let us know which in particular and we will certainly check to see if has
been made available!

The fields of data that are imported from a QuickBooks Online Item (of
type Service or Other Charge) object to an AyaNova Rate object are:

QuickBooks Online Item AyaNova rate

1 Name Rate Name
2 Sales information Description
3 Sales Price/Rate Retail Charge
4 Rate Type*
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*Whether a QuickBooks Online Item (of type Service or Other Charge) is
imported as a Service type or a Travel type is dependant on that you selected
Travel rate or Service rate in QBOI

QuickBooks Online Item (Service) fields identified:
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AyaNova Rate fields identified:
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3.3 How to import AyaNova data into QuickBooks

3.3.1 Why would I want to import my AyaNova data into my QB Online database?

Why would I import AyaNova data into my QB Online database?

· Importing your AyaNova data into your QB Online database automatically links
the data between your two databases (your AyaNova database and your QB
Online database) via QBOI so that the workorder's AyaNova customer and its
billable charges (i.e. parts and qty, service rate and qty) are linked to the
correctly linked QB Online customer and its billable charges (i.e. inventory
items, non-inventory items, )

· And by having these linked via QBOI, you can also easily and quickly update
existing information from one database to the other (i.e. update information
about a customer's address that you had edited in AyaNova into your QB Online
database; or update information about an inventory item you had edited in QB
Online and now want in your AyaNova database)

· If you are starting with a new empty QB Online, save yourself time by
importing your AyaNova data without the need to enter in again!

· Importing your existing AyaNova data into your QB Online database saves
you time - no need to manually enter the same record in your QB Online
database.

· If you have just finished configuring QBOI for the first time, after the following
message QBOI will open to the Map/Import screen defaulting to the Clients
objects.

This is an example screenshot only - you may have data on your QuickBooks Online side and/or
you may have different data on your AyaNova side
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· Or if at any time you need to link existing AyaNova objects with existing QB
Online objects at any time, select the menu Tools, than Map and import to
open the Map/Import screen - defaults to the Client Object selected,  showing
the AyaNova clients on the left and QuickBooks Online customers on the right. 

· Select the menu Object to drop down to select other objects you want to link
and/or import

3.3.2 Import via QBOI Main - clients, vendors, parts, rates

2 ways to import your AyaNova clients and/or parts into your QB Online database:
1. Can do so via QBOI Main with the basics as outlined below. 
2. Or you can import your AyaNova clients and/or parts into your QB Online database
via the the AyaNova relevant grid or entry screen.
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There is only 1 way to import AyaNova vendors and/or AyaNova rates:
1. Can do so via QBOI Main with the basics how to do so outlined below.

Basic steps how to import a single object into your QB Online database
via QBOI
Basic steps how to import multiple objects of the same type into your QB
Online database via QBOI
· Using SHIFT while selecting the first and last object listed

continuously
· Using CTRL while selecting non-continuously listed objects

Basic steps to import a single AyaNova object into your QB Online
database:

1. Click and hold down on the object indicator (the square to the left of the
AyaNova client or vendor)  <you will note that the object indicator now shows
an arrow within it>

2. Now drag it to the Drop here to import AyaNova item(s) <you will note

that your cursor changes to a  while being dragged>
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3. Release over the Drop here to import AyaNova item(s) and confirmation
that you want to import will display.

4. And then the imported QB Online object will display on the QuickBooks Online
"side" along with the linked symbol just like that shown in How to manually
link existing data

Basic steps to import multiple AyaNova objects of the same type at one
time:

Two ways: 
· 1st using SHIFT if selecting continuous list of objects;
· 2nd using CTRL if selecting non-continuous objects in list

1st method using SHIFT if selecting continuous list of objects

1. Select the first AyaNova object and than holding the SHIFT key when you
select the last AyaNova object <note how all from the first selected to the last
are highlighted> . 
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2. Now drag it to the Drop here to import AyaNova item(s) <you will note

that your cursor changes to a  while being dragged>

3. Release over the Drop here to import AyaNova item(s) and confirmation
that you want to import will display.
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4. And then the imported QB Online object will display on the QuickBooks Online
"side" along with the linked symbol just like that shown in How to manually
link existing data

2nd method using CTRL if selecting non-continuous objects in list

1. Select the first AyaNova item, hold the CTRL key and select more AyaNova
items <note how only the items selected are highlighted> . 

2. Now drag it to the Drop here to import AyaNova item(s) <you will note

that your cursor changes to a  while being dragged>



104

AyaNova QBOI Help 
 
                                                                                                                                                                                                                   © 1999 - 2018 Ground Zero Tech-Works Inc

Mapping & Importing

3. Release over the Drop here to import AyaNova item(s) and confirmation
that you want to import will display.

4. And then the imported QB Online object will display on the QuickBooks Online
"side" along with the linked symbol just like that shown in How to manually
link existing data

NOTE: QBOI only obtains QB Online and AyaNova information when QBOI first
loads
If you enter new information into either QuickBooks Online or AyaNova with QBOI
running, you need to refresh the connections

3.3.3 Import via AyaNova grid or entry screen - clients and/or parts

2 ways to import your AyaNova clients and/or parts into your QB Online database:
1. Can do so via QBOI Main. 
2. Or you can import your AyaNova clients and/or parts into your QB Online database
via the the AyaNova relevant grid or entry screen as outlined below
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There is only 1 way to import AyaNova vendors and/or AyaNova rates:
1. Can do so via QBOI Main.

Import your AyaNova Parts into your QB Online database from your
AyaNova Parts grid/ entry screen menu option
· Example of importing a single AyaNova part into your QB Online from your

AyaNova parts grid
· Example of importing multiple AyaNova parts into your QB Online from

your AyaNova parts grid

Import your AyaNova Clients into your QB Online database from your
AyaNova Clients grid/ entry screen menu option
· Example of importing a single AyaNova client into your QB Online from the

Client's record itself
· Example of importing AyaNova client(s) into your QB Online from your

AyaNova Clients grid

Import your AyaNova Parts into your QB Online database using the QBOI
quick menu options in the AyaNova Parts grid menu, and/or the Part's
entry screen menu 

Below is an example of importing a single  AyaNova part into
QuickBooks Online from the AyaNova Part grid:

1. First select the part record you want to import by selecting its row selector

. 
You can tell the row is selected as in addition to the row being highlighted,
also all fields are underlined.
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2. Select the PlugIns menu option in the Parts grid menu and select AyaNova
QBOI -> Export unlinked items to QuickBooks

If the menu option Export item to QuickBooks is not listed, that means 

3. Select Yes to export

4. Select the QuickBooks Online COGS Account, Income Account and Asset
Account for this part, and set whether taxable or not (or if non-US version of
QB Online, select the specific Tax Code to use with with imported item in your
QB Online)

Image below is for a US version of QB Online Plus with Inventory ability, whereas a non-US
version of QB Online would have an actual QB Online Tax Code selectable under Taxes
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NOTE: If the object(s) pre-selected in a grid are already linked via your
QBOI (i.e. mapped or imported previously into your QB Online), or if you
already have an Item in your QB Online database with the same Number
you may receive a message stating so.

Refer to what the message states is the issue.

Also refer to Common Issues & Messages

 

5. Confirmation the part has been imported into your QB Online will show as
STUB Done. Click OK.
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6. Via your QBOI Main, the part number now shows under QuickBooks

Online as well shows as linked  when view your QBOI Tools -> Map
& Import -> Object -> Parts

7. And in your refreshed QB Online, you can see that the Item with the
available imported fields of data along with what the total of AyaNova On
Hand amounts were at that time, and the total reorder amount.

Below is an example of importing multiple  AyaNova parts into your
QB Online from the AyaNova Parts grid:

1. Hold down the CTRL key on your keyboard for non-continuously listed part
records when selecting, 
or hold down the SHIFT key selecting the first part and then the last part
record you want to import for continuous listed parts. 

You can tell what records are selected as in addition to the row being
highlighted, also all fields are underlined.
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Then the exact same steps as above with importing a single AyaNova part
into your QB Online would be followed - refer to above screenshots above for
examples.

2. Select the PlugIns menu option in the Parts grid menu and select
AyaNova QBOI -> Export unlinked items to QuickBooks

3. Select Yes to export

4. Select the QuickBooks Online COGS Account, Income Account and Asset
Account for this part, and set whether taxable or not (or if non-US version of
QB Online, select the specific Tax Code to use with with imported item in your
QB Online)

NOTE: If the object(s) pre-selected in a grid are already linked via your
QBOI (i.e. mapped or imported previously into your QB Online), or if you
already have an Item in your QB Online database with the same Number
you may receive a message stating so.
Refer to what the message states is the issue.
Also refer to Common Issues & Messages

5. Confirmation the part has been imported into your QB Online will show as
STUB Done. Click OK.

6. Via your QBOI Main, the part number now shows under QuickBooks

Online as well shows as linked  when view your QBOI Tools -> Map
& Import -> Object -> Parts
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7. And when viewed in your refreshed QB Online, you can see the Items with
the available imported fields of data along with what their total of AyaNova
On Hand amounts were at that time, and their total reorder amount.

Import your AyaNova Clients into your QB Online database via the Plugins
quick menu options in the AyaNova Clients grid menu, and/or from the
Client's entry screen Plugins menu 

Below is an example of importing a single AyaNova client into
QuickBooks Online from the AyaNova Client entry screen

1.a. If the AyaNova Client has not yet been linked or imported into your QB
Online, your menu option under plugins for AyaNova QBOI will show
Export to QuickBooks Online
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1.b. If the AyaNova Client already has been linked or imported into your QB
Online, your menu option under plugins for AyaNova QBOI will show
Refresh AyaNova record and Refresh QuickBooks Online record

2. If the client is not yet imported and linked via your QBOI, click Yes to
export

3. Select the Tax setting applicable to your country version of QB Online

i.e. if US version of QB Online

i.e. if taxble or not if non-US version of QB Online
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4. Confirmation the Client has been imported into your QB Online will show
as Done. Click OK.

5. Via your QBOI Main, the part number now shows under QuickBooks

Online as well shows as linked  when view your QBOI Tools -> Map
& Import -> Object -> Clients

6. And in your refreshed QB Online, you can see the Customers with the
available imported fields of data 

Below is an example of importing AyaNova client(s) into your QB
Online from the AyaNova Client grid

1. To import multiple AyaNova clients that are listed continuously into your
QB Online, hold down the SHIFT key selecting the first part and then the last
part record you want to import. 
To import multiple AyaNova clients that are listed non-continuously into your
QB Online, hold down the CTRL key on your keyboard and select each client.
You can also select a single client as per the example below:

Note how you can tell what records(s) are selected as in addition to the rows
being highlighted, also all fields are underlined.
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2. Select the PlugIns menu option in the Parts grid menu and select
AyaNova QBOI -> Export unlinked items to QuickBooks

3. Select Yes to export

4. Select the Tax setting applicable to your country version of QB Online

i.e. Tax Account to use if using a US version of QB Online
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i.e. Is Taxable or not if using a non-US version of QB Online

NOTE: If the object(s) pre-selected in a grid are already linked via your
QBOI (i.e. mapped or imported previously into your QB Online), or if you
already have a cusetomer in your QB Online database with the same name
you may receive a message stating so.
Refer to what the message states is the issue.
Also refer to Common Issues & Messages

5. Confirmation the part has been imported into your QB Online will show as
Done. Click OK.

6. Via your QBOI Main, the client name now shows under QuickBooks Online

as well shows as linked  when view your QBOI Tools -> Map &
Import -> Object -> Clients

7. And in your refreshed QB Online, you can see the Customers with the
available imported fields of data 

3.3.4 AyaNova clients data imported into QuickBooks

When importing your AyaNova clients into your QB Online database via the QBOI
Main interface or when importing via the AyaNova grid or entry screen plugin menu
option, the following identifies the specifics fields of data that will be imported into
your QB Online customer from an AyaNova Client:

· If a field is not listed here as imported, than that AyaNova field's data is not
imported into the QB Online object. 

· As Intuit makes more online fields available for importing, we hope to add more
fields imported. Let us know which in particular and we will certainly check to see
if has been made available!

Additional QB Online that may be required information to be set when importing
The fields of data that are imported from your AyaNova client object to your QB
Online customer object
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Additional QB Online that may be required information to be set when
importing:

Additional data depends on what country version of QB Online you are using -
US version of QB Online or a non-US version of QB Online

· If using a US version of QB Online:

oWhen importing AyaNova client(s) into US version of QB Online: 

1. Requires selecting a specific QB Online tax code to assign to the
AyaNova client object(s) being imported into your US version of QB
Online database. 

NOTE: It is recommended to set up your Tax Codes in your QB
Online before importing your AyaNova clients objects into your QB
Online database, otherwise you may have to go back into your QB Online
database and manually edit each imported customer in your QB Online
database with the desired Tax Code.

NOTE: You can and will be prompted whenever you import one or more
AyaNova clients into your QB Online database, so if you have different
customers that need to have different tax codes assigned in your
QB Online, just import all those with the same tax code to be set at the
same time. Then import the next batch of AyaNova client objects that use
a different tax code, set the tax code to use, and import. And so on.

Reminder: If you make any changes in either your AyaNova or your QB
Online database, for those changes to show via your QBOI, don't forget
to refresh your connection

· If using a NON-US version of QB Online:
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· Importing AyaNova client(s) into a non-US version of QB Online:
 

1. You will not be asked to set a tax code for client objects imported

The fields of data that are imported from your AyaNova Client object to
your QB Online Customer object are:

AyaNova client QB Online customer

NOTE: Default Tax Code selected at time of
import if US version of QB Online
NOTE: Terms are set based on what
selected previously in your QBOI
Preferences

1. Client Name Display Name as
2. Email Email
3. Business Phone
4. Fax Fax
5. Home Other
6. Physical Address Shipping Address
6a. Street
6b. City
6c. State or Province
6d. Postal / Zip code
6e. Country
7. Postal Address Billing Address
7a. Street
7b. City
7c. State or Province
7d. Postal / Zip code
7e. Country

AyaNova client fields identified:
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QB Online customer fields identified:
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3.3.5 AyaNova vendors data imported into QuickBooks

The following identifies the specifics fields of data that will be imported into your QB
Online vendor from an AyaNova vendor when importing via QBOI Main interface:

· If a field is not listed here as imported, than that AyaNova field's data is not
imported into the QB Online object. 

· As Intuit makes more fields available for importing, we hope to add more fields
imported. Let us know which in particular and we will certainly check to see if has
been made available!

NOTE:

· So that you can use your AyaNova inventory features such as Part requests,
Purchase Order auto-filled for the correct Wholesaler, etc do map or import
your AyaNova Wholesalers before importing your AyaNova parts into your QB
Online

· An AyaNova vendor could be one of five different types of vendor - Wholesaler,
Third party repair center, SubContractor, Shipper, or Manufacturer
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· Whereas with QB Online does not distinguish between different types of
vendors.

The fields of data that are imported from an AyaNova Vendor object to a
QuickBooks Online Vendor object are:

AyaNova vendor QB Online vendor

1. Vendor Name Display Name As
2. Account Number Account No.
3. Email Email
4. Business Phone
5. Fax Fax
6. Home Other
7. Postal Address
7a. Street as shown in image below 
7b. City as shown in image below
7c. State or Province as shown in image below
7d. Postal / Zipcode as shown in image below
7e. Country as shown in image below

AyaNova vendor fields identified:
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QuickBooks Online vendor field identified:
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3.3.6 AyaNova parts data imported into QuickBooks

Whether importing your AyaNova Parts into your QB Online database via the QBOI
Main interface or when using importing your AyaNova parts using the AyaNova
grid/entry screen plugin menu option, the following identifies the specifics fields of
data that will be imported into your QB Online Item (Inventory)/(Non-inventory)
from an AyaNova Part:

· If a field is not listed here as imported, than that AyaNova field's data is not
imported into the QB Online object. 

· As Intuit makes more QB Online fields available for importing, we hope to add
more fields imported. Let us know which in particular and we will certainly check
to see if has been yet been made available!

Additional information to review before importing your AyaNova parts
into your QB Online database 
· When importing AyaNova part(s) into US version of QB Online
· When importing AyaNova part(s) into non-US version of QB Online

The fields of data that are imported from an AyaNova part object to a
QuickBooks Online Item

Additional information to review before importing your AyaNova parts
into your QB Online database 
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· If using a version of QB Online that does not support Inventory Items (i.e. at
time of writing this documentation only Plus versions support Inventory) before
importing your AyaNova parts into your QB Online, you may want to look
instead to linking multiple AyaNova parts to one QB Online Non-inventory Item
as QBOI will ensure that the actual name of the part as shown in your AyaNova
workorder will display in your QB Online invoice, while at the same time you
only need to deal with one or more Non-inventory Items in your QB Online.

· If you will be using your QB Online Purchase Orders, etc do map or import
your AyaNova vendors of type Wholesalers before importing your AyaNova
parts into your QB Online so that the AyaNova part's Wholesaler is stated in the
imported QB Online Item.

· As you may want different QB Online Items to be associated with different QB
Online COGS account, a different Income Account, a different Asset Account,
whether taxable or not (if US version) or associated with a different Tax Code
(if non-US version) - import these parts separately so you can select the specific
different account(s) / set the different Tax info for those specific parts being
imported.
§ i.e. Use your CTRL key with your mouse to specifically select non-

continuously listed AyaNova parts that have the same type (Inventory or
Non-inventory), same relevant account(s) and same relevant tax. Repeat as
necessary.

§ i.e. Use your SHIFT key with your mouse to specifically select continuously
listed AyaNova parts that have the same type (Inventory or Non-inventory),
same relevant account(s) and same relevant tax. Repeat as necessary.

· The QuickBooks Online On Hand and Restock amount will be set to that of
the total of all warehouses in AyaNova for that AyaNova part that is imported
as a QB Online Item

· Serial Numbers from AyaNova are not imported into your QB Online Item

· When importing AyaNova part(s) into US version of QB Online:

1. Before performing any import of AyaNova part(s) into your QB Online
database, either:

a. linked your existing AyaNova Wholesalers associated with the
AyaNova parts with existing QB Online Preferred Vendor(s) 

b. or import your AyaNova Wholesalers that are set as the Wholesaler for
the AyaNova part(s) you will be importing.
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This is so that the Preferred vendor can be stated in the QB Online Item
that is created in your QB Online database is already linked either through
a manual link or through an import.

2. When performing the import of the AyaNova part into your QB Online
via either the method of via QBOI Main or via your AyaNova grid, you will
be presented with similar to below:

2.a. Regardless of what type of QB Online you are connected to (i.e. Simple
Start, Essentials, or Plus), you will be required to select the following
account to associate the imported Item(s) with:

· Income Account
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2.b. What type of QB Online account you are using (i.e. Simple Start,
Essentials, or Plus) will dictate whether you have the option to import the
AyaNova part(s) selected as an Inventory Item OR as a Non-
Inventory Item 

2.b.i. If using the US version of QB Online Plus that supports Inventory
Items:

You will have the option to select to import as an Inventory Item
OR as a Non-Inventory Item 

If select to import as Non-Inventory Item, the two account
selections will be grayed out.

If select to import as Inventory Item, then you will be required to
select the following two additional accounts:
· Asset Account
· COGS Account

2.b.ii. If using a US version of QB Online (i.e. Simple Start, Essentials)
that does not supports Inventory Items:

You will only have the option to import as a Non-Inventory Item. 
Only Non-inventory is selected. Inventory item will be grayed out.
And the two account selections will be grayed out.

3. Requires setting whether the part is taxable or not. 
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So if some AyaNova parts should be imported as Inventory and some as Non-
Inventory, if some AyaNova parts should be imported with a different Income
Account and/or a different Asset Account and/or a different Cost Of Goods Sold
(COGS) Account or should not be taxable, import those parts separately from
when importing other parts so you can select the appropriate setting for those
parts.

· When importing AyaNova part(s) into non-US version of QB Online:

1. Before performing any import of AyaNova part(s) into your QB Online
database, either:

a. linked your existing AyaNova Wholesalers associated with the AyaNova
parts with existing QB Online Preferred Vendor(s) 

b. or import your AyaNova Wholesalers that are set as the Wholesaler for
the AyaNova part(s) you will be importing.

This is so that the Preferred vendor can be stated in the QB Online Item that
is created in your QB Online database is already linked either through a
manual link or through an import.

2. When performing the import of the AyaNova part into your QB Online
via either the method of via QBOI Main or via your AyaNova grid, you will
be presented with similar to below:

Example screenshot below for a Canadian company using the Canadian version of Plus
QB Online:
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2.a. Regardless of what type of QB Online you are connected to (i.e. Simple
Start, Essentials, Plus, etc), you will be required to select the following
account to associate the imported Item(s) with:

· Income Account

2.b. What type of QB Online account you are using (i.e. Easy Start, Simple
Start, Essentials, Plus - different country versions have different names) will
dictate whether you have the option to import the AyaNova part(s) selected
as an Inventory Item OR as a Non-Inventory Item 

2.b.i. If using the non-US version of QB Online Plus that supports
Inventory Items:

You will have the option to select to import as an Inventory Item
OR as a Non-Inventory Item 

If select to import as Non-Inventory Item, the two account
selections below it will be grayed out.

If select to import as Inventory Item, then you will be required to
select the following two additional accounts:
· Asset Account
· COGS Account
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2.b.ii. If using a non-US version of QB Online (i.e. Essentials) that does
not supports Inventory Items:

You will only have the option to import as a Non-Inventory Item. 
Only Non-inventory is selected. Inventory item will be grayed out.
And the two account selections will be grayed out.

1
3. Requires selecting an existing QB Online tax code for the
Item(s)/Service(s) being imported. 

 

So if some AyaNova parts should be imported as Inventory and some as Non-
Inventory, if some AyaNova parts should be imported with a different Income
Account and/or a different Asset Account and/or a different Cost Of Goods Sold
(COGS) Account or should not be taxable, import those parts separately from
when importing other parts so you can select the appropriate setting for those
parts.

 



129

AyaNova QBOI Help 
 
                                                                                                                                                                                                                   © 1999 - 2018 Ground Zero Tech-Works Inc

Mapping & Importing

The fields of data that are imported from an AyaNova part object to a
QuickBooks Online item object are:

AyaNova part QB Online Item (inventory or non-
inventory)

1.       Part Number Name
2.       Part Display Format Sales Information
            (as set in your AyaNova Global Settings - example below shows format of
Number - Name - Manufacturer  )
**note what shows in these screenshots is example only as dependent on your
AyaNova Global Settings for the Part Display Format before  you authorized
and signed in to your QB Online for this session**
2a. Part Number    
2b. Part Name
2c. Manufacturer
3.       Cost Cost
4.       Retail Sales Price/Rate
5.       On Hand Quantity On Hand
            (total from all warehouses)
6.       Restock level Reorder Point
            (total from all warehouses)

7.                                                        COGS Account  (what you selected at time
of import)
8.                                                        Income Account  (what you selected at
time of import if applicable)
9.                                                        Asset Account  (what you selected at time
of import if applicable)

AyaNova Part customer fields identified:

https://www.ayanova.com/AyaNova7webHelp/index.html?display_settings.htm
https://www.ayanova.com/AyaNova7webHelp/index.html?display_settings.htm
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QB Online Item fields identified:
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3.3.7 AyaNova rates data imported into QuickBooks

The following identifies the specifics fields of data that will be imported into your QB
Online Item (Service) from an AyaNova Service Rate or an AyaNova Travel Rate
when importing via the QBOI Main interface:
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· If a field is not listed here as imported, than that AyaNova field's data is not
imported into the QB Online object. 

· As Intuit makes more fields available for importing, we hope to add more fields
imported. Let us know which in particular and we will certainly check to see if has
been made available!

NOTE:  

· To minimize the number of rates in your QB Online, it may be suggested to link
all of your AyaNova Service rates to a single QB Online service Item. Because
when QBOI initiates an invoice in your QB Online from an AyaNova workorder,
the AyaNova Service Rate's price or Travel Rate's price will be used regardless
what is the price set in your QB Online.

· But you certainly can import all your AyaNova rates into your QB Online if you
wish!

· All AyaNova rates whether Service or Travel are imported into your QB Online
as Item type  "Service"

· Select to import/link Service Rates -> Service rate (or select Travel rate if want
to import your AyaNova travel rates into QuickBooks Online)

· An Income Account for the specific Rates must be selected
· Taxes:
o US version of QB Online will have Taxes: set as taxable or not
o Non-US versions of QB Online will have Taxes: where you can select a

specific Tax Code for this/these Rates being imported. 

· If you have different AyaNova rates that need to be assigned to different Asset
Accounts, and/or different tax settings,  than select to import only those rates
with the same Income Account and the same Tax setting at the same time.

· Below is an example of what is displayed with a US version of QB Online
before completing the import of the selected AyaNova rates.
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The fields of data that are imported from an AyaNova rate object to a
QuickBooks Online item object are:

AyaNova rate QuickBooks Online item (Service)

1. Rate Name Name
2. Retail Charge Sales Price/Rate
3. Description Sales information
4. Income Account
5. Taxes

If US version: Set as taxable or not
If non-US version: select the specific Tax

Code to use

AyaNova Part Rate fields identified:

QB Online Item (Service) fields identified:
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Updating Linked Clients and Parts
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4 Updating Linked Clients and Parts

4.1 Via QBOI Main update only AyaNova part's cost and retail price

You can update just the AyaNova parts Cost and Retail with the cost and retail from
the QuickBooks Online linked part via the main QBOI program through the
Map/Import menu option.

NOTE the following:
 

· This feature updates only the AyaNova's Part Retail Price and Cost fields 
· This feature does not update other fields of the AyaNova Part 
· This feature does not change any existing AYaNova workorder's Part price or

cost 
· QBOI can only update the price and cost of what your QB Online item price and

cost was at the time QBOI was first opened. If you have edited the QuickBooks
Online item price/cost since opening QBOI, you need to refresh the QB
connection before performing this action.

For example, let's say that you edited your part pricing for one or more parts in your
QB Online. When you run QBOI in AyaNova, do the following to update the existing
linked AyaNova part pricing automatically:
 

1. Your QB Online part's price and/or cost has been updated

But your AyaNova part's price and/or cost shows as was originally
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3. Refresh your QB connection

2. In Map / Import select Parts

 
2. Select the menu option Update AyaNova Prices

 
3. QBOI will ask you to confirm that you want to change all linked AyaNova
parts to current connection's QuickBooks Online item price and cost 

4. QBOI will compare each linked AyaNova Part's price and cost with the linked
QuickBooks Online item price and cost at the time when QBOI was opened/last
refreshed. 
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If the linked QuickBooks Online item price and/or cost is different, QBOI will
change the AyaNova part's price and/or cost.
This could be 1 part that is updated, this could be 1000's of parts - either way,
saving you time!

5. Once the update is completed, QBOI will identify how many AyaNova part's
prices (Retail and Cost) were updated, and when you click on OK, will close QBOI
 so that you can re-open it so are displaying the updated data.

 

NOTE: QBOI only obtains QuickBooks Online and AyaNova information when
QBOI first loads
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If you enter new information into either QuickBooks Online or AyaNova with QBOI
running, you need to refresh the connections.
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4.2
 
Via AyaNova's grid/entry screen update linked outdated QB

Online Items

An example of use:
1. One or more QBOI linked AyaNova Parts have been manually edited.
2. These fields are fields of data that can be imported from your AyaNova Part to

your QB Online Item. 
3. And you want that information also in your QBOI linked QB Online Item(s)

without having to manually edit your QB Online Item(s).
4. Use the AyaNova Parts grid or Part entry screen menu option Refresh

QuickBooks record to do this

Fields of the QB Online Item that can be updated if changed in your
QBOI linked AyaNova Part:

· Name
· Sales Information
· Cost
· Sales/Price Rate

NOTE: Fields of the QB Online Item that can not be updated if changed
in your QBOI linked AyaNova Part:

· Quantity On Hand
· Reorder point 

Below is an example of steps to update the QBOI linked older QB Online
Item record data with the edited latest AyaNova Part record data:

1. Refresh your connection to make sure accessing the latest information

If you have edited your Global Settings Part Display Format, you will need to
save and exit out of AyaNova which will require logging back in, starting
QBOI and authenticating again
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2. You can select one or more specific part records from your AyaNova Parts
grid by holding down the CTRL key and using your mouse to select each
records row selector.

Or you can select all Parts showing in the list by select the  at the
top of the AyaNova grid

Or you can select continuous listing of AyaNova parts records rows by holding
down your SHIFT key while using your mouse to select the first and the last
row selector.

Or open the specific AyaNova part record.

In this example we are selecting a single part record you want updated in the
Part's grid (you could instead for a single Part, just open its entry screen  and
perform the same steps from within the record itself). Note how you can tell it
is selected in the Part's grid as in addition to the row being highlighted, also
all fields are underlined.

2. Select the PlugIns menu option in the Parts grid menu and select AyaNova
QBOI -> Refresh QuickBooks  record
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3. Click on Yes to update the Quickbook's part information to that of the
AyaNova part.

4. It will show Done when completed

5. Now when you refresh your view of your QBOI items, you will see the
updates that have been applied.

NOTE: QBOI only obtains QuickBooks Online and AyaNova information when
QBOI first loads
If you enter new information into either QuickBooks Online or AyaNova with QBOI
running, you need to refresh the connections.
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4.3 Via AyaNova's grid/entry screen update linked outdated
AyaNova Parts

An example of use:
1. One or more QBOI linked QB Online Item(s) fields have been manually edited.
2. These fields are fields of data that can be imported from your QB Online Item to

your AyaNova Part. 
3. And you want that information also in your QBOI linked AyaNova Part(s)

without having to manually edit your AyaNova Part(s).
4. Use the AyaNova Parts grid or entry screen menu option Refresh AyaNova

record to do this

Fields of the AyaNova Part that can be updated if changed in your
QBOI linked QB Online Item:

· Part Number
· Cost
· Retail

NOTE: Fields of the AyaNova Part that can not be updated if changed
in your QBOI linked QB Online Item:

· On Hand
· Restock level 

Below is an example of steps to update the older AyaNova data with the
edited latest QB Online data:

1. Refresh your connection to make sure accessing the latest information

2. You can select one or more specific part records from your AyaNova Parts
grid by holding down the CTRL key and using your mouse to select each
records row selector.

Or you can select all Parts showing in the list by select the  at the
top of the AyaNova grid
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Or you can select continuous listing of AyaNova part records rows by holding
down your SHIFT key while using your mouse to select the first and the last
row selector.

Or open the specific AyaNova part record.

In this example, select the part record you want updated in your AyaNova
Part's grid (you could instead for a single Part, just open its entry screen and
perform the same steps from within the record itself). Note how you can tell it
is selected in the Part's grid as in addition to the row being highlighted, also
all fields are underlined.

2. Select the PlugIns menu option in the Parts grid menu and select AyaNova
QBOI -> Refresh AyaNova  record
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3. Click on Yes to update the AyaNova part's information to that of the QBOI
linked QB Online Item.

4. It will show Done when completed

NOTE: QBOI only obtains QuickBooks Online and AyaNova information when
QBOI first loads
If you enter new information into either QuickBooks Online or AyaNova with QBOI
running, you need to refresh the connections
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4.4 Via AyaNova's grid/entry screen update linked outdated QB
Online Customers

An example of use:
1. One or more QBOI linked AyaNova client's fields have been manually edited.
2. These fields are fields of data that can be imported from your AyaNova Client to

your QB Online customer. 
3. And you want that information also in your QBOI linked QB Online customer(s)

without having to manually edit your QB Online customer(s).
4. Use the AyaNova Client grid or Client entry screen menu option Refresh

QuickBooks record to do this

Below is an example of steps to update the QBOI linked older QB Online
customer record data with the edited latest AyaNova client record data:

1. Refresh your connection to make sure accessing the latest information

2. You can select one or more specific client records from your AyaNova
Clients grid by holding down the CTRL key and using your mouse to select
each records row selector.

Or you can select all Clients showing in the list by select the  at the
top of the AyaNova grid
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Or you can select continuous listing of AyaNova client records rows by
holding down your SHIFT key while using your mouse to select the first and
the last row selector.

Or open the specific AyaNova client record.

In this example, select the client record you want updated in the Client's grid
(you could instead for a single Client, just open its entry screen and perform
the same steps from within the record itself). Note how you can tell it is
selected in the Client's grid as in addition to the row being highlighted, also all
fields are underlined.

2. Select the PlugIns menu option in the Parts grid menu and select AyaNova
QBOI -> Refresh QuickBooks  record
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3. Click on Yes to update the Quickbook's customer information to that of the
AyaNova client.

4. It will show Done when completed

5. Now when you refresh your view of your QBOI customers, you will see the
updates that have been applied.

NOTE: QBOI only obtains QuickBooks Online and AyaNova information when
QBOI first loads
If you enter new information into either QuickBooks Online or AyaNova with QBOI
running, you need to refresh the connections
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4.5 Via AyaNova's grid/entry screen update linked outdated
AyaNova Clients

An example of use:
1. One or more QBOI linked QB Online customer's fields have been manually

edited.
2. These fields are fields of data that can be imported from your QB Online

customer to your AyaNova Client. 
3. And you want that information also in your QBOI linked AyaNova Client(s)

without having to manually edit your AyaNova Client(s).
4. Use the AyaNova Client grid or Client entry screen menu option Refresh

AyaNova record to do this

Below is an example of steps to update the QBOI linked older AyaNova
client record data with the edited latest QB Online customer record
data:

1. Refresh your connection to make sure accessing the latest information

2. You can select one or more specific client records from your AyaNova
Clients grid by holding down the CTRL key and using your mouse to select
each records row selector.

Or you can select all Clients showing in the list by select the  at the
top of the AyaNova grid
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Or you can select continuous listing of AyaNova client records rows by
holding down your SHIFT key while using your mouse to select the first and
the last row selector.

Or open the specific AyaNova client record.

In this example, select the client record you want updated in the Client's grid
(you could instead for a single Client, just open its entry screen and perform
the same steps from within the record itself). Note how you can tell it is
selected in the Client's grid as in addition to the row being highlighted, also all
fields are underlined.

2. Select the PlugIns menu option in the Clients grid menu and select
AyaNova QBOI -> Refresh AyaNova  record
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3. Click on Yes to update the AyaNova client's information to that of the QBOI
linked QB Online customer.

4. It will show Done when completed

5. Now when your view of your AyaNova client(s) is refreshed, you will see
the updates that have been applied.

NOTE: QBOI only obtains QuickBooks Online and AyaNova information when
QBOI first loads
If you enter new information into either QuickBooks Online or AyaNova with QBOI
running, you need to refresh the connections.
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5 Descriptive Text

5.1 What is Descriptive Text?

Why set up Descriptive Text?

When you use QBOI to invoice out billable items from an AyaNova workorder into
a QB Online invoice, you could print a workorder report from AyaNova and
physically provide the report along with the QB Online invoice.

OR you could specify in your QBOI's Descriptive Text feature to show text from
specific areas of the AyaNova workorder on the QB Online invoice itself! Thereby
not needing to include a copy of the AyaNova service workorder.

Descriptive Text is set via the Tools -> Invoice descriptive text template menu
option from the main QBOI screen

· You can set as much or as little descriptive text about the service
workorder(s) to display on your QB Online invoices. 

· You can set using the pre-set defaults (detailed default or brief default), and/or
edit directly what you wish to display, or have no additional text display

For example, the screenshot below shows that this invoice has the additional
descriptive text from the AyaNova workorder identifying the following:

· what AyaNova workorder number the invoice is for
· text from the AyaNova workorder Item Summary field
· text about the unit serviced in the display format set in your AyaNova's

Global Settings for unit display
· and details about the labor service provided
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Because the Invoice descriptive text template had the following settings:
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5.2 Service workorder data that can be entered as descriptive text

Service workorder data fields that are selectable to be included via
descriptive text in a QuickBooks Online invoice via QBOI

Where ever you see text that is preceded and followed by a ~ symbol in each of
the text areas - these are referred to as tokens

Tokens in the descriptive text template denotes to QBOI to obtain the data for
that token from the service workorder if applicable.

For example,  ~W0#~ will be replaced by the service workorder number.

Each of the text areas corresponds to a section of a AyaNova service workorder.

If the service workorder data field is not listed here, than it can not be entered as
descriptive text on a QB Online invoice via QBOI.

But if the data is needed to be seen by your client - it is suggested to either:

a. enter it manually in the QB Online invoice itself before providing to your
client.

b. print out an AyaNova Detailed Completed Workorder report to accompany
the invoice so that all details are provided to the client along with the invoice

c. have your client log in via their Customer Login via your optional add-on RI
and/or your optional add-on WBI so they can view the full details of that
workorder.

From the service workorder header fields text area section:

Screenshot below shows the correspondence of the service workorder header
fields with the selection in the descriptive text template.

· Select Client contact  to insert the ~CONTACT~ token to represent the
data from the billable service workorder's Contact field  into the workorder
header fields text area

· Select Client reference number  to insert ~CREF#~
· Select Internal reference number  to insert ~OURREF#~
· Select Project name  to insert ~PROJ~
· Select Workorder client name  to insert ~CLIENT~
· Select Workorder number  to insert ~WO#~
· Select Workorder service date  to insert ~SERVDATE~

https://www.ayanova.com/RI_remote_field_service.htm
https://www.ayanova.com/WBI_Web_browser_interface_field_service.htm
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· Select Workorder status name  to insert ~STAT~
· Select Workorder summary  to insert ~DESC~

 

From the workorder items fields text area section:

Screenshot below shows the correspondence of the service workorder item
fields with the selection in the descriptive text template.

· Select Workorder item summary  to insert the ~ITEM_SUMMARY~ token
to represent the data from the billable service workorder item's Item
Summary field into the workorder items text area

· Select  Workorder item service notes  to insert
~ITEM_SERVICE_NOTES~

· Select Workorder item type  to insert ~ITEM_TYPE~
· Select  Workorder item request date  to insert ~ITEM_REQUEST_DATE~
· Select Workorder item status  to insert ~ITEM_STATUS~
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From the Unit text area section:

· Select AyaNova unit display format  to insert the ~AYAFORMAT~ token
to represent the Global Settings format of the selected unit in that billable
service workorder into the Unit text area

· Select Unit serial number  to insert ~UNIT_SN~
· Select Unit meter reading  to insert ~UNIT_METER~  (note - only a meter

reading that was entered via the meter reading steps as outlined in the
AyaNova Help file How To enter a unit meter reading via a Service
Workorder )

· Select Manufacturer  to insert ~UNIT_MAKE~
· Select Unit model name  to insert ~UNIT_MODEL_NAME~
· Select Unit model number  to insert ~UNIT_MODEL_DESC_NUMBER~

From the Labor text area section:

Screenshot below shows the correspondence of the service workorder Labor
with the selection in the descriptive text template.

· Select Start date and time  to insert the ~SERVICE_START~ token to
represent the Labor record's Start Date & Time into the Service text area

· Select Stop date and time  to insert ~SERVICE_STOP~
· Select Quantity  to insert ~SERVICE_QUANTITY~
· Select Rate name  to insert ~RATE_NAME~
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· Select Technician  to insert ~SERVICE_TECH~ (this is the schedulable user
that is selected in the Labor record)

· Select Details  to insert ~DETAILS~
· Select No charge quantity  to insert ~NO_CHARGE_QUANTITY~

From the Travel text area section:

Screenshot below shows the correspondence of the service workorder Travel
with the selection in the descriptive text template.

· Select Start date and time  to insert the token ~TRAVEL_START~ to
represent the Travel's record Start Date & Time of the invoiced workorder
item into the Travel text area

· Select Stop data and time  to insert ~TRAVEL_STOP~
· Select Quantity  to insert ~TRAVEL_QUANTITY~
· Select Travel rate name  to insert ~TRAVEL_RATE_NAME~
· Select Technician  to insert ~TRAVEL_TECH~
· Select Details  to insert ~TRAVEL_DETAILS~
· Select Distance  to insert ~TRAVEL_DISTANCE~
· Select No charge quantity  to insert

~TRAVEL_NO_CHARGE_QUANTITY~
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From the Outside Service text area section:

Screenshot below shows the correspondence of the service workorder Outside
Service with the selection in the descriptive text template.

· Select Repair price  to insert the token ~REPAIR_PRICE~ to represent the
Repair Price field from the Outside Service section of the service workorder
item  into the Outside Service text area

· Select Shipping charges  to insert ~SHIP_CHARGE~
· Select  Date sent  to insert ~SENT~
· Select Date returned  to insert ~RETURNED~
· Select Notes  to insert ~NOTES~

From the Expenses text area section:

Screenshot below shows the correspondence of the service workorder
Expenses with the selection in the descriptive text template.

· Select Charges  to insert the token ~CHARGES~ to represent the Charge
Amount field from the Expenses record for the invoiced workorder item into
the Misc.Expenses text area

· Select Summary  to insert ~SUMMARY~
· Select Description  to insert ~DESCRIPTION~
· Select Technician  to insert ~TECH~
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From the Loans text area section:

Screenshot below shows the correspondence of the service workorder Loans
with the selection in the descriptive text template.

· Select  Item loaned  to insert the token ~ITEM~ to represent the Loan Item
from the Loans section of the service workorder item that is invoiced into
the Loans text area

· Select Charges  to insert ~CHARGE~
· Select Loaned Date  to insert ~LOANED~
· Select Returned Date  to insert ~LOAN_RETURNED~
· Select Notes  to insert ~LOAN_NOTES~
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5.3 Editing the Descriptive Text Template

1. From the main QBOI screen, select the Tools -> Invoice descriptive text
template menu option

2. You can use either:
A. Set to default brief format 
B. Set to default detailed format
C. Or edit the format manually

A. Set to default brief format

To display just the text "Charges for the workorder:" and the workorder
number associated with the QB Online invoice, than just select the menu
option Set to default brief format.  

This is useful so that either:

a. the client can reference the included Detailed Completed Service
Workorder report you have printed out/emailed/included with their QB
Online invoice - especially if you have a lot of detail in the service workorder
which the QuickBooks Online invoice may span many many pages to
display.

b. or so that your client can reference their specific workorder details via
their Customer Login via your optional add-on RI and/or your optional add-
on WBI

https://www.ayanova.com/RI_remote_field_service.htm
https://www.ayanova.com/WBI_Web_browser_interface_field_service.htm
https://www.ayanova.com/WBI_Web_browser_interface_field_service.htm
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B. Set to default detailed format

Or if you do want the QB Online invoice to display text about everything
billable from the service workorder, than select the menu option Set to
default detailed format.  

Do note QB Online invoices are very limited in the amount of text that can
display, so your invoice may span multiple pages. 

Once set, a suggestion would be to invoice one workorder first, before
invoicing numerous workorders, so you can confirm is showing what data you
want and need from the AyaNova workorder(s) on the QB Online invoice.

C. Editing manually what service workorder data to display:

You can edit specifically what text you want to display and what data from the
AyaNova service workorder by placing your cursor with the text area, entering
any text, and than select the menu option Insert xxxxx field (where xxxxx
will be the section of the AyaNova service workorder it corresponds to )

Data field tokens ONLY display for their specific sections - for example, do not
manually enter ~WO#~ in the Unit: text area field and expect the workorder
number to display. That is why the menu option at the top is for selection for
that specific text area.
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Do note QB Online invoices are very limited in the amount of text that can
display, so your invoice may span multiple pages if you include numerous
data field tokens. 

An example of manually editing:

All you want is if a specific unit in a workorder item was selected for service,
you want the following to display on the QuickBooks Online invoice:

Serial Number of serviced equipment: serial number

Click in the Unit: text area and you will note that the menu changes to Insert
unit field:
Type in the text (and/or replace the existing text and data fields) you want to
display such as Serial Number of serviced equipment:
Than select the menu option Insert unit field: to drop down the list of
selectable data fields from the Unit section of the service workorder and select
 
Note how the ~AYAFORMAT~ is inserted into that text area.



Invoicing
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6 Invoicing

6.1 How to invoice AyaNova workorders into QuickBooks invoices

Now that you have done the following...

· set your QBOI Preferences, 
· have edited your Descriptive Text so that text from the AyaNova workorder

shows on the QB Online invoice if desired
· have linked existing data between AyaNova and QB Online
· and/or imported your QB Online data (customers, vendors, items) into your

AyaNova
· and/or imported your AyaNova data (clients, vendors, rates, parts) into your

QB Online

... now you are ready to invoice AyaNova workorders into QB Online invoices.

Reminder - QBOI displays what is present in your AyaNova and in your QB
Online at the time QBOI was last refreshed (i.e. when first loaded, or when
last refreshed). So if you are not seeing something you expect to, refresh!

To invoice AyaNova workorders into QB Online invoices:

1. Have QBOI running and authenticated - see Starting QBOI 

2. If the QBOI Main window states no invoiceable work orders found in
AyaNova, but you know you "do" have workorders that need to be invoiced,
then you need to confirm as per the message and as per the section No service
workorders ready for invoicing

3. If your QBOI Main window displays the client name with an image of a

orange circle with a line through it  and/or a workorder number with a
orange circle with a line through it  such as example below:    

This tells you that perhaps one or more of the following needs to be
addressed: 
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1. the AyaNova client of that workorder has not yet been linked/imported
between your AyaNova and your QB Online

2. and/or parts in the AyaNova workorder are not yet linked/imported with
a corresponding Item in your QB Online

3. and/or parts in the AyaNova wokorder have a different price than that of
the linked QB Online Item

4. See the specific how to fix each above, but regardless you will start
with selecting Invoices -> Fix Problems

4. If displays with the AyaNova customer name with a checkmark  image 
beside it and a + sign (indicating one or more workorders associated with that
client ready for billing), then proceed:

5. If you want a single AyaNova workorder to be invoiced out in a single
QuickBooks Online invoice

6. If you want multiple AyaNova workorders for the same client to be invoiced
out to a single QuickBooks Online invoice

7. If you have a number of service workorders all for different clients ready for
invoicing, you can have QBOI have QuickBooks Online invoice all workorders at
one time into respective invoices

8. Refer to What happens when QBOI invoices?
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6.2 No service workorders ready for invoicing

If the main QBOI screen displays as the screen shot below:

As the message states - there are no service workorders that meet the
four setting requirements to be able to have QBOI ready them for invoicing
via your QB Online database.

If you do have service workorders that you know are ready for invoicing but the
above message displays there are no workorders ready, do the following 6 steps:

In your AyaNova:
1. Confirm that the workorder's Service Completed field is check-marked
2. Confirm that the Closed field is not check-marked
3. Confirm that the Invoice #: field is empty
4. Confirm that the Workorder Status is set to that you set in your
Preferences for Billable Workorder Status <screen shot below  of
workorder status may not reflect what you have actually selected in your
preferences>

5. If you make any changes to the workorder, be sure to Save & Exit.
In your QBOI Main:
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6. Select the menu option Invoices -> Refresh invoices so that QBOI
rechecks to see if there now are workorders that are ready for invoicing

NOTE: QBOI only obtains QuickBooks Online and AyaNova information when
QBOI first loads and when it is refreshed.
If you enter new information into either QuickBooks Online or AyaNova with QBOI
running, you need to refresh the connections
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6.3 Fix AyaNova client not yet linked/imported with your QB Online

If your QBOI Main displays AyaNova clients and workorders an orange circle with

a link through it image    When that may indicate one or more of the
following problems needs to be fixed.

1. The AyaNova client of that workorder has not yet been
linked/exported from your AyaNova to your QB Online which we will
cover in this help section below

2. and/or parts in the AyaNova workorder are not yet linked/imported with a
corresponding Item in your QB Online

3. and/or parts in the AyaNova wokorder have a different price than that of the
linked QB Online Item

1. To determine which problem(s) need fixing, start with selecting Invoices ->
Fix Problems

2. All problems needing to be fixed at this moment will be listed - below is an
example only
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3. In this section, we will go over how to address the problem of an AyaNova
Client not yet linked or exported yet to your QB Online

4. For the row where the ObjectType is Client and the Problem is
NotLinkedToQB select under the Fix column Link/Export

5. Possible options to resolve will be displayed:

a. Link to an existing QB Online item
b. Or import the AyaNova part's data into your QB Online which will also link

6. In our example above, we have selected to Import to QB

7. Continue with fixing any other outstanding problems until your QBOI Main
shows the avaiable workorder(s) with a  image next to it to indicate there are
no problems and is ready for invoicing.
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8. Now invoice:

a. If you want a single AyaNova workorder to be invoiced out in a single
QuickBooks Online invoice

b. If you want multiple AyaNova workorders for the same client to be
invoiced out to a single QuickBooks Online invoice

c. If you have a number of service workorders all for different clients ready
for invoicing, you can have QBOI have QuickBooks Online invoice all
workorders at one time into respective invoices

d. Refer to What happens when QBOI invoices?



173

AyaNova QBOI Help 
 
                                                                                                                                                                                                                   © 1999 - 2018 Ground Zero Tech-Works Inc

Invoicing

6.4 Fix AyaNova part not yet linked/imported with your QB Online

If your QBOI Main displays AyaNova clients and workorders an orange circle with

a link through it image    When that may indicate one or more of the
following problems needs to be fixed.

1. The parts in the AyaNova workorder are not yet linked/imported
with a corresponding Item in your QB Online which we will cover in this
help section below

2. and/or the AyaNova client of that workorder has not yet been linked/exported
from your AyaNova to your QB Online 

3. and/or parts in the AyaNova wokorder have a different price than that of the
linked QB Online Item

1. To determine which problem(s) need fixing, start with selecting Invoices ->
Fix Problems

2. All problems needing to be fixed at this moment will be listed - below is an
example only
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3. In this section, we will go over how to address the problem of a part not yet
linked via your QBOI to a corresponding Item in your QB Online

4. For the row where the ObjectType is Part and the Problem is
NotLinkedToQB select under the Fix column Link.

5. NOTE: when the problem is that the AyaNova part is not linked to a QB Online
Item, you can not import the AyaNova part into your QB Online via here
- your only option is to link it to an existing QB Online item via this method. 

If instead you DO want to import the AyaNova part or rate into your QB Online,
you will need to import these into QuickBooks Online using either the Map and
Import menu option, or import the part via the AyaNova part grid or part entry
screen.
So if you DO want to import instead, exit out of the Fix invoice problems,
perform those steps to import and don't forget to refresh after! 

6. Otherwise, drop down the list of available QuickBooks Online items to link this
AyaNova object to, and select an existing QB Online Item to link to
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7. Continue with fixing any other outstanding problems until your QBOI Main
shows the avaiable workorder(s) with a  image next to it to indicate there are
no problems and is ready for invoicing.

8. Now invoice:

a. If you want a single AyaNova workorder to be invoiced out in a single
QuickBooks Online invoice

b. If you want multiple AyaNova workorders for the same client to be
invoiced out to a single QuickBooks Online invoice

c. If you have a number of service workorders all for different clients ready
for invoicing, you can have QBOI have QuickBooks Online invoice all
workorders at one time into respective invoices

d. Refer to What happens when QBOI invoices?
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6.5 Fix AyaNova part that has different price than QBO price

If your QBOI Main displays AyaNova clients and workorders an orange circle with

a link through it image    When that may indicate one or more of the
following problems needs to be fixed.

1. The parts in the AyaNova wokorder have a different price than that
of the linked QB Online Item which we will cover in this help section
below

2. and/or parts in the AyaNova workorder are not yet linked/imported with a
corresponding Item in your QB Online

3. and/or the AyaNova client of that workorder has not yet been linked/exported
from your AyaNova to your QB Online 

1. To determine which problem(s) need fixing, start with selecting Invoices ->
Fix Problems

2. All problems needing to be fixed at this moment will be listed - below is an
example only
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3. In this section, we will go over how to address the problem of a part not yet
linked via your QBOI to a corresponding Item in your QB Online

4. For the row where the ObjectType is Part and the Problem is
PriceDifference select under the Fix column Fix Price.

5. Possible options to resolve will be displayed:

Before invoicing, if there is a price difference, on a part by part basis you will
have the choice of:

a. Use the workorder price as it is; even though it's different
· Leaving the retail price as is in this AyaNova service workorder, and then

QBOI will tell your QB Online to invoice the linked Item at that AyaNova
retail price in your QB Online invoice.

· **If selected, but you exit out of QBOI before completing the invoicing,
you will again have to fix this problem before invoicing

b. Set the workorder item's price to the QuickBooks price
· Will cause the retail price and cost in this AyaNova service workorder to

be changed to that of linked QB Online Item, and QBOI will tell your QB
Online to invoice the linked Item at the QB Online retail set price.

· **if selected, this affects the workorder item part price immediately,
even if you close QBOI before invoicing

c. Set the AyaNova object's default price to be the QuickBooks price
from now on
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· Will cause the retail price in this AyaNova service workorder to be
updated to that of QB Online Item, AND ALSO updates the AyaNova part
retail price in the AyaNova part to that of the QB Online object for future
selections in AyaNova workorders, and QBOI will tell your QB Online to
invoice the linked Item at its own retail price. 

· **if selected, this affects the AyaNova part object price, as well as the
part price in the service workorder immediately, even if you close QBOI
before invoicing

d. Set the QuickBooks object's default price to be the AyaNova price
from now on
· Will result in the retail price left as it is in this AyaNova service

workorder, will update the retail price in your QB Online Item to that of
the AyaNova part retail price, and QBOI will tell your QB Online to
invoice out at that AyaNova retail price in the QB Online invoice 

· **if selected, this affects the QB Online part price immediately even if
you close QBOI before invoicing

Note that the first two just change the workorder price and do not affect the
existing AyaNova part itself nor the QB Online Item when selected in any other
workorder or invoice - whereas the last two actually change the price of the QB
Item as well as the part price in that workorder. 

6. In our example, we have selected to Use the workorder price as it is;
even though it's different because this customer gets a 20% discount off the
regular price.

7. Continue with fixing any other outstanding problems until your QBOI Main
shows the avaiable workorder(s) with a  image next to it to indicate there are
no problems and is ready for invoicing.

8. Now invoice:
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a. If you want a single AyaNova workorder to be invoiced out in a single
QuickBooks Online invoice

b. If you want multiple AyaNova workorders for the same client to be
invoiced out to a single QuickBooks Online invoice

c. If you have a number of service workorders all for different clients ready
for invoicing, you can have QBOI have QuickBooks Online invoice all
workorders at one time into respective invoices

d. Refer to What happens when QBOI invoices?
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6.6 Taxes

QBOI does not and can not use the tax code selected in your AyaNova service
workorder billable items.

QBOI does not import or export tax codes between AyaNova and your QB Online

Whether your QB Online invoice taxes are based on the country version of your QB
Online.

US QB Online:
· A specific tax code is set for the QB Online customer that is applied to each QB

Online Item/Service that itself can be  set to Taxable or not. 

non-US QB Online (i.e. Canadian QB Online, UK QB Online, etc):
· Taxes are based on the individual QB Online Item's tax code selection. 

If an invoice in your QB Online that was generated via QBOI has an incorrect tax
code or codes, check what is set for that QB Online client or for that QB Online Item
(inventory or service) depending on your country version of QB Online.
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6.7 Parts invoicing includes wo's Description and/or Serial Number

What displays in the QB Online Description field for the specific linked QB Online
Item sold depends on:

§ If the AyaNova Part being billed out is linked to an QB Online Item
(Inventory) or to a QB Online Item (Non-inventory)

Whether additional QB Online Description field(s) display under the specific linked
QB Online Item sold depends on:

§ If the AyaNova Part is serialized or not.
§ If there is text in the AyaNova workorder Part's Description field or not.

If the AyaNova Part being billed out is linked to an QB Online Item
(Inventory) or to a QB Online Item (Non-inventory)

If the AyaNova Part being billed out is linked to an QB Online Item
(Inventory)
· Then your QB Online invoice line will display in the invoice's Description

field the Sales Information stated of that specific QB Online Item
(Inventory) that is linked to the AyaNova part being billed out,
irregardless what the AyaNova part is displayed as in your AyaNova
workorder.
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If the AyaNova Part being billed out is linked to an QB Online Item (Non-
Inventory)
· QBOI will have your QB Online invoice display as text the workorder's part

based on its Part Display Format in its Global Settings in the Description of
linked QB Online (Non-inventory item) and NOT use the actual Sales
Information text of the  linked QB Online (Non-inventory item).

§ this way your invoice will always identify the specific display
name of the specific part sold as stated in your AyaNova
workorder, as majority of QB Online users that have a Non-
Inventory type version will link multiple AyaNova parts to a single
QB Online non-Inventory Item
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If the AyaNova Part is serialized or not

If the AyaNova Part is serialized, your QB Online invoice will always also show
under the linked Item (whether the Item is Inventory or non-Inventory) an
additional Description that states this serial number from the AyaNova
workorder.
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If there is text in the AyaNova workorder Part's Description field or not

If there is text in the AyaNova workorder's Part's Description field, that text will
also always show under the linked AyaNova Item (whether Inventory or non-
Inventory) as an additional Description text line.
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6.8 Discount % set in Parts is applied via a QuickBooks invoice

QBOI does apply discounts set in the AyaNova workorder to the QB Online invoice
generated from it via QBOI.

If you have applied a discount on a part record in an AyaNova workorder, that
net price which is the AyaNova part price X the discount will be identified by
QBOI

If the AyaNova net price (part price X discount) is different than that of your QB
Online item price, QBOI will identify that there is a price problem that needs to
be addressed and will identify it as due to a discount (i.e Price XX.XX
discounted XX% on workorder)

See also:
Fix AyaNova part that has a different price that QBO price
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6.9 Banked service invoiced out at 0$

QBOI will identify if a labor item in an AyaNova workorder has been banked via
Banked Service, and will always invoice it at 0$ amount.

Banked service in AyaNova is pre-payment for services.
Refer to your AyaNova Help documentation for more on Banked Service.

As your client has pre-paid already for service, and you have in AyaNova itself
banked the service charges against their pre-paid amount, the client will not be
re-billed for that service.
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6.10 Travel or Service Rate retail charges

When QBOI requests that your QB Online generate an invoice for the AyaNova
workorder's Labor Service billable information, your QB Online invoice will take by
default the AyaNova Service Rate's Retail Charge price no matter what the price is
set for the linked Item (Service) in your QB Online.

Same when QBOI passes over the AyaNova workorder Travel billable information to
your QB Online - your QB Online invoice will take by default the AyaNova Travel
Rate's Retail Charge price no matter what  the price is set for in the linked Item
(Service) in your QB Online

This way you only need to maintain the rates in AyaNova at their different retail
prices when linked to one QB Online item. 

You are not notified if there is a discrepancy between the AyaNova rate's Retail
Charge and the linked QuickBooks Online item's Rate. Because it is expected to
use the price set in your AyaNova rate in the workorder.

In the screen shots below, the QB Online item Hours is linked to multiple
AyaNova service rates. This way your QB Online has only one Service Item that is
used to bill out Labor, with your AyaNova maintaining the different rate price for
each service.
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The QB Online item Hours shows a Sales price/rate of $0.00
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With this QBOI feature, the rate is always billed out at the correct specific
AyaNova rate's Retail Charge
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6.11 Misc Expenses charges

AyaNova QBOI will use the QuickBooks Online item selected in Preferences as
the item to use when billing Expenses.

· AyaNova QBOI will take the AyaNova service workorder Expenses Charge
Amount price no matter what is the Rate set for the linked Item is in your
QuickBooks Online.

· You are not notified if there is a discrepancy between the AyaNova service
workorder Expenses Charge Amount price and the linked QuickBooks Online
item's Rate.

· Also note that QBOI takes the Charge Amount only, as QBOI does not transfer
the taxes identified on service workorders. Whether taxed or not, and at what
rate is determined by the linked Item in your QB Online

· The Charge Amount is transferred to the QuickBooks Online invoice, and the
default tax as set in QuickBooks Online is applied. Therefore ensure that the tax
setting in QuickBooks Online for the Expenses is set correctly - or edit the
invoice after QBOI creates it - or for future charges, edit the QuickBooks Online
item tax setting default.
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6.12 Outside Service charges

AyaNova QBOI will use the QuickBooks Online item selected in Preferences as
the item to use when billing Outside Service charges.

· AyaNova QBOI will take by default the AyaNova service workorder Outside
Service Repair Price + Shipping Price combined no matter what is the
Rate set for the linked item in QuickBooks Online.

· In the example screenshot below, Repair Price = $100 + Shipping Price = $15,
so what is set in the QB Online invoice is amount of $115.00 ($100 = $15).

· What tax if any is applied is based on the tax setting of the QB Online Item.

· You are not notified if there is a discrepancy between the Outside Service
combined Repair Price + Shipping Price amount and the linked QuickBooks
Online item's Rate.
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6.13 Invoicing indivdual AyaNova service workorders via QBI into
QuickBooks

If you have a number of service workorders ready for invoicing that are all for the
same client, you can have QBOI have QuickBooks Online invoice each service
workorder individually by selecting the specific workorder to be invoiced.

1. QBOI lists by the client. In the screenshot below we have service workorders
ready to be invoiced for two different clients.

2. You can expand to see what workorders are for each client by selecting the +

image  beside each client name < note how the +  image turns to a -  image
when you select it to show it is expanded >

3. To invoice a specific AyaNova service workorder into one QuickBooks
Online invoice

a. Select the row object indicator (the square to the left of the specific
workorder that you want specifically invoiced by itself if multiple workorders
are listed or if the client has only one workorder ready to be invoiced, you
can select the row object indicator to the left of the client name)
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b. Now either right-click and select Invoice selected items to QuickBooks
Online... One workorder per invoice

c. Or with that object indicator selected, select the menu Invoices ->
Invoice selected items to QuickBooks Online... One workorder per
invoice

4. Once a service workorder has been invoiced, it no longer displays in the list and
you can continue invoicing individually or invoicing multiple service workorders for
the same client or invoice all ready service workorders.
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Do be aware because of the QuickBooks Online invoice space limitations, your
descriptive text may cause the invoice to span many pages. 
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6.14 Invoicing multiple service workorders for one client into one
QuickBooks invoice

If you have a number of service workorders ready for invoicing that are all for the
same client, you can have QBOI have QuickBooks Online invoice all those into one
invoice to the same linked QuickBooks Online client.

1. QBOI Main lists by the client. 

In the screenshot below we have two different clients with a checkmark  image
 beside their name and a + sign (indicating one or more workorders associated
with that client ready for billing)

If instead you see an image of a orange circle with a line through it  , that
indicates one or more problems to be fixed before being able to invoice.

2. Expand to see what workorders are for each client by select the  beside each

client name <note how the  image turns to a  image when you select it to
show it is expanded>

3. To invoice all AyaNova service workorders for one client into one
QuickBooks Online invoice
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a. Select the object indicator for the client (the square to the left of the client
name)

b. Now either right-click and select -> Invoice selected items to
QuickBooks... Multiple workorders per invoice

c. Or with that that client object indicator selected, select the menu Invoices
-> Invoice selected items to QuickBooks... Multiple workorders per
invoice

4. Once all service workorders for a client have been invoiced, the client no longer
displays in the list as there are no further workorders for that client to invoice. 
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Do be aware because of the QuickBooks Online invoice space limitations, your
descriptive text may cause the invoice to span many pages. 
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6.15 Invoicing all ready service workorders

If you have a number of service workorders all for different clients ready for
invoicing,  you can have QBOI have QuickBooks Online invoice all workorders at one
time into respective invoices.

1. In the screenshot below we have service workorders ready to be invoiced for
three different clients (with no problems to be fixed as shown by the green ready
next to the client name).

2. If we expand each of the clients, we can see that two of the clients have
multiple service workorders to be billed out
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3. We can either:

A. invoice all workorders for all clients, with each client getting only
one invoice even if have multiple workorders
· 1 invoice for Green Frank that includes all billables for workorder 44 and for

workorder 75
· 1 invoice for ABC Accounting that includes all billables for workorder 50 and

workorder 54 and workorder 61 and workorder 70
· 1 invoice for Notting But Ham Deli for workorder 74

OR 

B. invoice all workorders for all clients, each workorder to its own
invoice
· a total of 7 separate invoices - 2 invoices for Green, Frank; 4 invoices for ABC

Accounting; and 1 invoice for Notting But Ham Deli)

A. invoice all workorders for all clients, with each client getting one
invoice even if multiple workorders

· hold the CTRL key from your keyboard and select the object indicator for
each of the three clients. You can tell all three clients have been selected as all
three clients are highlighted.
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· Now we select the menu Invoices -> Invoice selected items to
QuickBooks...Multiple workorders per invoice

· There will be three invoices created in your QuickBooks Online

· 1 invoice for Green Frank that includes all billables for workorder 44 and for
workorder 75

· 1 invoice for ABC Accounting that includes all billables for workorder 50 and
workorder 54 and workorder 61 and workorder 70

· 1 invoice for Notting But Ham Deli for workorder 74

B. invoice all workorders for all clients, each workorder to its own
invoice

· Hold down your CTRL key from your keyboard and select the object indicator
for each of the three clients. You can tell all three clients have been selected as
all three clients are highlighted.
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· Now we select the menu Invoices -> Invoice selected items to
QuickBooks...One workorder per invoice

· There will be seven invoices created in your QuickBooks Online - one for each
workorder listed.
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6.16 What happens when QBI invoices?

1. QBOI display screen:

The listed AyaNova clients and their billable workorders will no longer display in
the QBOI Main list as they have now been invoiced via your QB Online

2. The QB Online invoice(s) was/were generated:

· Workorder header descriptive text (if applicable) is placed before any charges
· Billable items for that service workorder are than listed
o Parts are listed first, than Service, than Travel, than Expenses, than Loans and

than Outside Service charges.
o If multiple workorder items with the same parts or labor etc, all billable items

are billed out individually.
o For example, if billed out the same labor rate in multiple workorder items in

the same workorder, each billable amount per labor item is listed separately
· Additional Descriptive Text set in QBOI is than listed for that service workorder

(if set to use Descriptive Text)
· If multiple workorders billed on the same invoice, than the next workorder

billable information is listed starting with workorder header descriptive text if
applicable and so on as above

3. The AyaNova service workorder is updated with the following:

· Workorder Status in the workorder header area is updated to the status set in
your Preferences for Post billing workorder status 

· The Invoice #: field is filled with the corresponding QB Online invoice number
· If the Preference "Close Workorder After Invoicing" has been check-

marked, the AyaNova service workorder is set to the Closed state, no longer be
edited by any user, and available for historical viewing and reporting. (if you do
need to un-Closed a workorder, do refer to your AyaNova Help documentation
about this specific field)

http://www.ayanova.com/AyaNova7webHelp/index.html?the_service_workorder_header.htm
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